Copyright

The information contained within this document regarding LogTag Analyzer software usage is intended as a guide and does not constitute a declaration of performance. The information contained in this document is subject to change without notice. Unless otherwise noted, the example companies, organizations, e-mail addresses and people depicted herein are fictitious, and no association with any real company, organization, e-mail address or person is intended or should be inferred. Complying with all applicable copyright laws is the responsibility of the user.

No representation or warranty is given and no liability is assumed by LogTag Recorders with respect to the accuracy or use of such information or infringement of patents or other intellectual property rights arising from such use or otherwise.

Copyright © 2004-2013 LogTag Recorders. All rights reserved.
http://www.logtagrecorders.com
# Contents

## Introduction

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>9</td>
</tr>
</tbody>
</table>

## Installing the software

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>System requirements</td>
<td>11</td>
</tr>
<tr>
<td>Getting a copy of the software</td>
<td>11</td>
</tr>
<tr>
<td>The installation process</td>
<td>13</td>
</tr>
<tr>
<td>Upgrading LogTag Analyzer</td>
<td>14</td>
</tr>
<tr>
<td>Starting the software</td>
<td>15</td>
</tr>
</tbody>
</table>

## Quick Start Guide

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connecting the Interface</td>
<td>18</td>
</tr>
<tr>
<td>Using the LogTag with the Interface</td>
<td>19</td>
</tr>
<tr>
<td>Preparing a LogTag for recording</td>
<td>20</td>
</tr>
<tr>
<td>Welcome</td>
<td>22</td>
</tr>
<tr>
<td>Locate LogTag(s) download and save relevant data</td>
<td>22</td>
</tr>
<tr>
<td>Configure LogTag(s) for next use</td>
<td>23</td>
</tr>
<tr>
<td>Prepare LogTag(s) for next use</td>
<td>24</td>
</tr>
<tr>
<td>Starting and using the LogTag</td>
<td>25</td>
</tr>
<tr>
<td>LogTag light patterns</td>
<td>27</td>
</tr>
<tr>
<td>Retrieve information from LogTag</td>
<td>28</td>
</tr>
</tbody>
</table>

## Preparing LogTag(s) for use

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Getting a LogTag ready for use</td>
<td>30</td>
</tr>
<tr>
<td>Restricting Access</td>
<td>31</td>
</tr>
<tr>
<td>Protecting Recorded Data</td>
<td>31</td>
</tr>
<tr>
<td>Password Rules</td>
<td>32</td>
</tr>
<tr>
<td>Preparing LogTag for next use</td>
<td>32</td>
</tr>
<tr>
<td>Alert Processing</td>
<td>37</td>
</tr>
<tr>
<td>Advanced Alert Settings</td>
<td>40</td>
</tr>
<tr>
<td>Display Logger Alarms</td>
<td>43</td>
</tr>
<tr>
<td>Verify Access Password</td>
<td>45</td>
</tr>
<tr>
<td>Pre-start data collection</td>
<td>45</td>
</tr>
<tr>
<td>Continuous operation</td>
<td>46</td>
</tr>
<tr>
<td>Working with batches of LogTags</td>
<td>46</td>
</tr>
<tr>
<td>Getting the best from your LogTag</td>
<td>46</td>
</tr>
<tr>
<td>Configuration Profiles</td>
<td>47</td>
</tr>
<tr>
<td>Profiles Grid</td>
<td>48</td>
</tr>
<tr>
<td>Profile Control Buttons</td>
<td>48</td>
</tr>
<tr>
<td>Profile Storage File Name and Path</td>
<td>49</td>
</tr>
<tr>
<td>Profile File Controls</td>
<td>50</td>
</tr>
<tr>
<td>Profile Window Controls</td>
<td>50</td>
</tr>
<tr>
<td>Quickly re-configuring LogTags</td>
<td>51</td>
</tr>
<tr>
<td>Automatic Re-Configuration after Download</td>
<td>52</td>
</tr>
<tr>
<td>Hibernation - Prolonging battery life</td>
<td>52</td>
</tr>
</tbody>
</table>
Results from LogTag

Getting results from LogTag ................................................................. 56
Saving LogTag Data ........................................................................... 57
  Saving LogTag Data files ............................................................... 57
  Saving a Multi Chart file ............................................................... 57
  Selected LogTag® Data files (*.sltd) ............................................ 58
  Saving a file for use in spreadsheets .......................................... 60
  PDF files ..................................................................................... 60
Analysing the results ........................................................................ 62
  Chart Display .............................................................................. 64
  Report Display ........................................................................... 73
  Data Display ................................................................................ 75
  Summary Display ........................................................................ 76
  Day Summary Display .................................................................. 77
Combining charts onto a single chart ............................................... 80
  Changing Chart Colours .............................................................. 81
  Shifting chart start times .............................................................. 81
  Aligning Charts .......................................................................... 82
  Special Chart Tabs ....................................................................... 84
Automatically calculated statistics .................................................. 87
  Average Reading ......................................................................... 87
  Standard Deviation ..................................................................... 88
  Mean Kinetic Temperature ........................................................... 90
  Degree Minutes .......................................................................... 92
Displaying statistics ......................................................................... 93
Printing the results ......................................................................... 94
Sending a file by e-mail direct from Analyzer .................................. 95
Calling up previous results ............................................................. 96
Digital signatures ........................................................................... 97
How secure is my data .................................................................... 99
Viewing file properties .................................................................. 100

Customising the software

General Settings ............................................................................... 104
  Default display time interval ...................................................... 104
Summary Statistics .......................................................................... 105
Chart Statistics ............................................................................... 105
Charts ............................................................................................ 106
Automation ..................................................................................... 107
  Reconfigure with same settings after automatic download ........ 108
File and Folder Settings .................................................................. 119
Exports and Reports ....................................................................... 123
Dates and Times ............................................................................. 125
Time zones ..................................................................................... 126
Communication Ports .................................................................... 127
User Server ..................................................................................... 127
Software Updates .......................................................................... 128
Configuration Reports ..................................................................... 129

Menus and Toolbars

Menu commands ............................................................................ 131
Contents

File Menu ......................................................................................................................... 131
Edit Menu .......................................................................................................................... 133
LogTag Menu ..................................................................................................................... 134
Window Menu .................................................................................................................... 135
Help Menu ........................................................................................................................ 136
Toolbar commands ........................................................................................................... 137
Print preview toolbar ....................................................................................................... 139
Standard Window commands .......................................................................................... 140

Getting more information ............................................................................................... 142
Finding your software version .......................................................................................... 142
Getting more help ............................................................................................................ 143

Appendix ......................................................................................................................... 144
Connecting to LogTag User Server .................................................................................. 144
  How users log on ................................................................................................................ 144
  How users change their password .................................................................................... 144
Troubleshooting ................................................................................................................. 146
Finding your computer specifications .............................................................................. 147
Code Pages ....................................................................................................................... 153

Index ............................................................................................................................... 159
Table of Figures

Figure 1: Confirmation download file request IE9 ................................................................. 12
Figure 2: Confirm download request in Mozilla Firefox ......................................................... 12
Figure 3: Downloading the LogTag Installer with Internet Explorer 9 .................................... 13
Figure 4: Downloading the LogTag Installer in Mozilla Firefox .......................................... 13
Figure 5: Downloading the LogTag Installer in Chrome ......................................................... 13
Figure 6: Checking for an update on the internet .................................................................. 14
Figure 7: Windows 7 Start Menu ......................................................................................... 16
Figure 8: Rear of PC with one serial port (RS232) ............................................................... 18
Figure 9: Rear of PC with 4 USB ports ................................................................................. 18
Figure 10: Standard interface cradle with LogTag ................................................................. 19
Figure 11: TIC20 interface cradle ......................................................................................... 19
Figure 12: TICT in interface cradle ....................................................................................... 20
Figure 13: Downloading a LogTag Recorder ........................................................................ 20
Figure 14: Downloading a LogTag Recorder ....................................................................... 28
Figure 15: Menu bar - LogTag Menu .................................................................................... 30
Figure 16: Password entry dialogue .................................................................................... 31
Figure 17: Profile main window .......................................................................................... 48
Figure 18: Profiles grid ....................................................................................................... 48
Figure 19: New Profile Window .......................................................................................... 49
Figure 20: Quick Re-configure option through menu ......................................................... 51
Figure 21: Hibernating a recorder ....................................................................................... 53
Figure 22: Downloading a LogTag Recorder ....................................................................... 56
Figure 23: Chart sample ..................................................................................................... 64
Figure 24: File window with zoomed chart ......................................................................... 65
Figure 25: Context menu in chart tab .................................................................................. 66
Figure 26: Manually scaling a chart .................................................................................... 67
Figure 27: Sample report tab .............................................................................................. 73
Figure 28: Report tab context menu .................................................................................... 74
Figure 29: Report tab in landscape format .......................................................................... 75
Figure 30: Sample data grid .............................................................................................. 75
Figure 31: Day summary display ......................................................................................... 78
Figure 32: Day summary display ......................................................................................... 79
Figure 33: Sample based standard deviation ................................................................. 88
Figure 34: Population based standard deviation .............................................................. 88
Figure 35: General Option Settings .................................................................................... 103
Figure 36: General Option Settings .................................................................................... 104
Figure 37: Automatic options pane .................................................................................... 107
Figure 38: Basic SMTP settings ......................................................................................... 111
Figure 39: Basic FTP settings ............................................................................................ 115
Figure 40: Running LogTag Software as administrator ..................................................... 128
Figure 41: Menu bar - LogTag Menu .................................................................................... 134
Figure 42: About LogTag window ..................................................................................... 142
Figure 43: Diagnostic data collection ................................................................................ 143
Figure 44: ASCII table of printable characters ................................................................... 153
Figure 45: Extended characters of code page 1252 (Latin) .............................................. 154
Figure 46: Extended character of code page 874 (Thai) .................................................. 154
Figure 47: Accessing the Character Map in Windows XP .................................................. 155
Figure 48: Accessing the Character Map in Windows 7 ...................................................... 155
Figure 49: Extended character of code page 932 (Japanese) ............................................ 156
Figure 50: Character sub set of code page 932 for leading 91........................................... 156
CHAPTER 1

Introduction

This guide will take you through the relevant steps to successfully use the LogTag® products. You will learn how to

▪ install the software,
▪ configure LogTags for recording,
▪ retrieve the recorded readings,
▪ display and analyse the data and
▪ configure the available options in the software so you can make best use of its features.

The chapters in this guide are placed accordingly. Experienced users of the software may choose to skip chapters 1 and 2, however if you are about to use a newer version of a LogTag or Interface Cradle we recommend you at least skim the installation chapter for any relevant changes.

This guide covers version 2.3 of the LogTag Analyzer software. If you are unsure which version you are currently using, please read Finding your software version (on page 142) included later in this guide. If you are using an older version, where you find a feature described in this guide that does not appear in your software, we recommend you update it as explained in Getting updated software. You can always get the most up to date version of LogTag Analyzer and a current version of this User Guide from the LogTag Recorders website at http://www.logtagrecorders.com.

This guide includes all the relevant information to install and use the product range supplied by LogTag Recorders, however occasionally the reader is expected to be familiar with using a computer and the Windows® operating system.

Feedback, positive or negative, about the software, the LogTag® products and this guide is welcome. If you believe the products could be improved, please send us your comments.
CHAPTER 2

Installing the software

To use your LogTags you will first need to install LogTag Analyzer on your computer. This will allow preparing the LogTag for recording, retrieving the readings from memory and analyze the data.

This chapter will take you through the steps necessary to successful install the software on to your computer. It should be very familiar to users that have previously installed other software, which is why some experienced users may choose to skip this chapter. If you are new to using a computer and/or unsure about installing the software, we recommend you read the remainder of this chapter.

In This Chapter

System requirements............................................. 11
Getting a copy of the software............................. 11
The installation process........................................ 13
Upgrading LogTag Analyzer .................................... 14
Starting the software............................................ 15
System requirements

To ensure that the software will work on your computer following minimum specifications are required:

- PC capable of running Windows XP or later, or Windows 2003 Server or later
- 60MB free disk space
- Internet Explorer 5.0 or later
- 1 available serial port and/or 1 available USB port, depending on purchased interface
- 1024 x 768, or higher, screen resolution.
- 256 screen colours

The recommended specifications are:

- Processor equivalent to Pentium IV or later
- 512MB of available RAM
- Internet Explorer 6.0 or later
- 65535 (16bit), or more, screen colours.

If you are unsure of what your computer specifications are, please read the section about Finding your computer specifications (on page 147), which will help you locate the relevant information.

Getting a copy of the software

The software is available for download from the LogTag Recorders website at http://www.logtagrecorders.com. LogTag Recorders does not charge for the download or use of this software, or for updates. You are welcome to distribute copies of the LogTag Analyzer software provided it is distributed unaltered and in the packaged format as originally downloaded from the LogTag Recorders website.
To obtain the software, visit the LogTag Recorders website and navigate to the software download page. Complete and submit the download request form. Within a few minutes you will receive an e-mail at the address entered in the form with a link for the latest download file. Click on the link and confirm whether you wish to open the downloaded file or save it to a folder on your PC.

Figure 1: Confirmation download file request IE9

Figure 2: Confirm download request in Mozilla Firefox
Depending on the type of browser and its version you may get different windows to start and process the download. Modern browsers like Windows Explorer, Google Chrome or Mozilla Firefox typically have a special directory into which all downloads are copied.

If you have an older browser, we recommend you select a folder on your PC that you can easily access (such as the "Documents" or "Downloads" folder), but you are free to choose any folder for which you have write permissions. The downloaded file is a single executable installer file; no other files are required for installation of LogTag Analyzer software on your computer.

Once the installation process has completed, the installer file is no longer required and can safely be deleted.

**The installation process**

To install the LogTag Analyzer software, locate the installation file downloaded in the previous step and execute it (typically by double clicking or selecting the file in Windows Explorer and pressing <Enter>). Follow the on-screen instructions. Initially, the process will require you to enter data such as your organisation and name, and select installer language and the program’s storage location. We recommend you leave all options at their default setting, especially if you are unsure of what option to select or what changing the option would mean.

To proceed through each step of the installation process, click the "Next" button. If you want to change a previous step you can click the "Back" button. When all required data have been
entered, click the "Finish" button to complete the installation process. If you want to stop installing the software, click the "Cancel" button.

The drivers required to operate your USB interface are installed as part of the main installation process. From time to time updated drivers may be released by LogTag Recorders. These drivers will be available through the Microsoft Windows® Update feature, as an optional hardware update, or as part of an upgraded installer file (see Upgrading from earlier versions on page 14.)

### Upgrading LogTag Analyzer

LogTag Recorders will publish updates to LogTag Analyzer to introduce new or enhanced features or to support new LogTag models. You can get these updates...

- ... automatically, if you have enabled "Automatic Updates" (see Software Updates on page 128)

  By default, this option is turned on. We recommend leaving this turned on, so you will automatically be notified when an update is available. You will see the following window, letting you choose to whether or not you wish to update at this stage:

  ![Check for Update](image)

  Figure 6: Checking for an update on the internet

  Neither of these two options will transmit any information about you or your system to LogTag Recorders, so you can rest assured your privacy is maintained.

- ... through the Help menu by selecting "Check Internet for update..."

  When you select this option, LogTag Analyzer will check the LogTag Recorders website for a newer version of the software

  ![Check for Update](image)

  Figure 6: Checking for an update on the internet

  LogTag Recorders recommend that you always use the latest version of the software.
If a newer version is available, you can download the updated version on page 11 of the installer file to your PC and then proceed with the installation process on page 13. The older version of the software will be replaced with the new version.

Installing a newer version will update all the relevant program files. It will not affect any of your LogTag data files or your custom settings of the software. You may however need to check any shortcuts to the program you made, as the location of the program files can change.

If you are upgrading from version 1.7r10 or earlier, the installed unsigned USB drivers will not be replaced automatically. To replace the USB drivers you will need to go to Windows Update and select the FTDI - USB Interface update from the "Other hardware" section. Please refer to your Operating System manual or help on how to access this feature.

You can also update your driver from the Control Panel device manager. Please see Resolving USB Driver Problems later in this document.

**Starting the software**

At the conclusion of the installation process click **Finish** to close the installer window.

You can start the software ...
... by double clicking the "Shortcut" on the desktop

... by navigating to the "Shortcut" in the "Start" menu system. Click on the "All Programs" item to locate the "LogTag Analyzer" shortcut, similar to the following picture:

![Windows 7 Start Menu](image)

Figure 7: Windows 7 Start Menu

... by selecting the LogTag Analyzer tile from the Start screen

Please refer to your operating system documentation for further assistance about program locations and how to execute programs.
CHAPTER 3

Quick Start Guide

This chapter will cover how you prepare your LogTag for use, how to start it and how to retrieve and analyse the recorded information. Subsequent chapters will explain this in more detail, and also show you how you can customise LogTag Analyzer’s settings to make your work easier.

In This Chapter

Connecting the Interface .............................................. 18
Using the LogTag with the Interface ................................. 19
Preparing a LogTag for recording .................................... 20
Starting and using the LogTag ........................................... 25
LogTag light patterns ......................................................... 27
Retrieve information from LogTag ................................. 28
Connecting the Interface

The interface cradles available from LogTag Recorders connect to either a serial (RS232) port or a USB (Universal Serial Bus) port, depending on the model you purchased.

The ports for *serial (RS232)* *communication devices* are typically located at the rear of the computer as shown here:

![Serial port (RS232)](image)

*Figure 8: Rear of PC with one serial port (RS232)*

Insert the plug into the port with the correct orientation. We recommend you tighten the securing screws when the connector is plugged in so that it does not accidentally pull out during use.

The ports for *USB devices* are typically also located at the rear of the computer, but you may find other ports at the front or sides of your computer. If you are using a USB hub we recommend it has its own power supply.

![USB ports](image)

*Figure 9: Rear of PC with 4 USB ports*

Connectors for USB devices will often display a USB logo such as this one so you can identify them easier:

![USB logo](image)

LogTag Analyzer can communicate with multiple interface cradles at the same time; you may connect as many serial and/or USB interface cradles as the computer supports, although we find that connecting more than 4 interfaces becomes impractical.
If you install LogTag Analyzer on a computer with no internet connection you must ensure USB interface cradles are not connected until the installation is completed, since the required drivers are installed as part of LogTag Analyzer.

If the software cannot identify a connected USB interface cradle there may have been a problem during the installation of the software. Please refer to the FAQ on the LogTag Recorders website for further information.

Using the LogTag with the Interface

Depending on the product you want to download you will need one of two different interface cradle types.

![Figure 10: Standard interface cradle with LogTag](image1)

![Figure 11: TIC20 interface cradle](image2)

Most products use the standard interface cradle, where the LogTag is inserted into the slot from the top as shown to enable communication. You will be able to see the contact pins inside the slot that meet with the matching contact pads on the LogTag. When inserting a LogTag into the slot you feel a slight resistance as the contacts engage. Removing the LogTag will cause a slight clicking noise as the contacts snap back into their unloaded position.

The indicator products TIC20 and TICT use a special cradle in which the contact pins are exposed at the top. To enable communication locate the indicator's lug on the interface's boss and firmly press it down, so the contact pins pierce through the rear label.
You can connect both interface types to your computer at the same time, provided you use different ports.

LogTag Analyzer will automatically download and display any readings or statistics stored inside the LogTag.

The download process will only take a few seconds, but you can stop it if needed by clicking on the button or pressing the "Esc" key.

Preparing a LogTag for recording

You can use two different methods to prepare a LogTag so it records information.

Using the LogTag Wizard

You can use the LogTag Wizard by either clicking the icon on the standard toolbar, or by clicking Wizard in the LogTag menu.

1. The Welcome screen is displayed.
2. All connected interface cradles are checked for inserted LogTag's. If any of them contain previously recorded data these are downloaded and saved.
3 A configuration window is displayed where you can enter details about the next recording trip, such as interval and duration.

4 The entered configuration data are uploaded to connected LogTag's.

**Without using the LogTag Wizard**

You can click **Configure** in the **LogTag** menu or use the F3 key. In this case the downloading and saving of data is skipped.

1 All connected interface cradles are checked for inserted LogTag's.

2 A configuration window is displayed where you can enter details about the next recording trip, such as interval and duration.

3 The entered configuration data are uploaded to connected recorders.

You can also use pre-configured profiles, or quickly re-configure a LogTag with the same settings as used for the previous recording. For more details on these options please see **Configuration Profiles** (on page 47) and **Quickly re-configuring LogTags** (on page 51).
Welcome

First the Wizard has a welcome screen (this is "1" on the Action List). This asks you to make sure you have not neglected to place the LogTag firmly in the Interface Cradle.

The Wizard is responsible for certain "Action Steps" and these are clearly listed at the left in the wizard window.

To get to the next screen, click on the Next button and the next wizard screen will appear. The green arrow will indicate you have moved to Step 2.

Locate LogTag(s) download and save relevant data
In this screen you will see one of the following pictures next to each of the items in the list:

- (no picture) indicates the software is still using this communications port.
- Data was successfully retrieved from the LogTag and stored/saved to disk.
- Data was successfully retrieved from the LogTag but there was no need to save the information to disk.
- The software was unable to detect an Interface Cradle connected to the communications port or was unable to detect a LogTag in the Interface Cradle.
- The LogTag is a single use logger and cannot be prepared for use again and should therefore be returned to the supplying distributor or agent once you have finished with the LogTag. You will still be able to continue to retrieve information stored within the LogTag.

The LogTag should be almost instantly recognized by serial number and the number of readings. It is possible to have and use more than one communication port at a time and if so, the wizard will find all the LogTags.

The communication ports that are not in use (the ones that initially are reported with the mark) can be removed from view by selecting an option (see "Communication Ports" on page 127). You don’t have to do that now, but you can do it later to clean up the "wizard window" appearance.

To get to the next screen, click on and the third wizard step screen will appear. The software will automatically proceed to the next wizard step, as if the user clicked on , if each of the Interface Cradles detected have a LogTag detected in them and the information within the LogTag was successfully retrieved.

**Configure LogTag(s) for next use**
The options are available so you have appropriate control over the way the LogTags will behave and store data for the upcoming period of recording. These options are explained in more detail in the chapter "Preparing LogTag for use on page 29". Click Next to record the configuration data and you will see the final confirmation screen.

**Prepare LogTag(s) for next use**

The last Wizard screen involves sending the new configuration data to each LogTag to prepare them for their next use. While the software is sending the new configuration data to each LogTag the top of the window will look similar to the following picture. The process of sending the new configuration data to each LogTag should take less than 20 seconds in total to complete.

Once the software has finished uploading the updated configuration information into each LogTag, the window displaying the progress will look similar to the following picture.

In this screen you will see one of the following pictures next to each of the items in the list:

- (no picture) indicates the LogTag is still in the process of being prepared for its next use.
- ✅ The LogTag was successfully prepared for its next use.
- ✗ The LogTag failed to be prepared for next use. Press Again to try again.
• 📈 The battery within the LogTag is low and is unlikely to have enough capacity to record all the data you want during its next use. In this situation the LogTag should no longer be used.

When all LogTags have finished receiving their new configuration data, click to close the wizard. Your LogTag(s) are now ready to be started and used.

Please note that the automatic download feature is disabled in this screen. If you use the button to configure a different LogTag, you may update the configuration of a LogTag with unsaved data.

Starting and using the LogTag

Once a LogTag has been successfully configured for use it is ready to be started. There are two discrete methods available to start a LogTag recording, which are selected during configuration. These start methods are explained in more detail in the chapter "Preparing LogTag for use on page 29".

1 By pressing and holding the START MARK button on the LogTag until both the OK and Alert lights alternately flash on and off.

2 By waiting until the date/time defined during configuration is reached, at which time recording will automatically commence. Pressing the START MARK button will have no effect until recording has commenced.

You can also have the LogTag record an "inspection" mark at any time while it is recording, simply by pressing and holding the START MARK button on the LogTag until both the OK and Alert lights flash on and off at the same time. You may have the LogTag record as many inspection marks as you want while it is recording, however only one inspection mark can be recorded per reading. In other words, if your LogTag is configured to take readings at 15 minute intervals, inspection marks can be recorded at intervals of 15 minutes or more. If the LogTag has finished recording then pressing the START MARK button will have no effect until after the LogTag has been prepared for next use.
Once the LogTag has started recording (either via Start button or date/time start) the Alert and OK indicator lights operate as detailed in the section about LogTag light patterns on page 27.
## LogTag light patterns

LogTags without a display signal a number of different events or status information by using their LED’s. The table below contains a summary of the light patterns you may come across during use.

<table>
<thead>
<tr>
<th>Signal</th>
<th>Sequence</th>
<th>Occurrence</th>
</tr>
</thead>
</table>
| LogTag wake-up signal         | Sequence of four alternate flashes of green-red LED’s                    | • displayed after configuration has been successfully applied to the LogTag.  
• when a LogTag is woken up from hibernation (see "Hibernation - Prolonging battery life" on page 52) state.  
Not to be mixed up with... |
| LogTag start-up signal        | Sequence of sixteen alternate flashes of green-red LED’s                 | • displayed when the LogTag starts its recording cycle.  
• displayed when pressing start/mark button while recording to indicate an inspection mark in the software.  
• displayed directly after the start-up signal following a push button start where a recording delay has been configured. In this instance the start-up signal is repeated when the actual recording begins. |
| Mark signal                   | Sequence of five simultaneous flashes of green and red LED’s             | • displayed when pressing start/mark button while recording to indicate an inspection mark in the software.  
• displayed directly after the start-up signal following a push button start where a recording delay has been configured. In this instance the start-up signal is repeated when the actual recording begins. |
| Logging active, no alert present | Single flash of green LED every 4 seconds (approx.)                     | • indicates LogTag is recording.  
This is not displayed when pre-start is active and the main logging cycle has not yet started. It is also not displayed when the green LED has been turned off in the configuration screen. |
| Logging finished, no alert present | Single flash of green LED every 8 seconds (approx.)                      | • indicates LogTag has finished recording.  
This is not displayed when the green LED has been turned off in the configuration screen.  
Will also be displayed when unit has been woken up from hibernation. |
| Alert condition present       | Single flash of red LED every 4 seconds                                  | • displayed when the LogTag has detected an alert condition (see "Alert Processing" on page 37) and the Alert LED has been activated.  
If an alert is present you cannot determine if the unit is still logging or has finished its log cycle. The Alert LED will flash every 4 seconds to ensure an alarm condition is not overlooked. |
| Communication                 | The green LED will flash occasionally                                    | • during communication with the interface the green LED will flash occasionally; no information is conveyed in this. |
| Start button press            | red LED glows faintly                                                     | • This is by design but conveys no information. |
Retrieve information from LogTag

When you are ready to view the recordings that are stored within the LogTag, just place the LogTag into the Interface Cradle as before. If the LogTag is still recording when you go to retrieve the readings it will continue to record without interruption so you will be able to download again later if you choose.

If the LogTag has readings stored within its memory, the software will automatically start to retrieve a copy of the recording contained within the LogTag and will also display an animated picture during the download process, similar to the following picture.

![Figure 14: Downloading a LogTag Recorder](image)

Once the readings have been successfully retrieved from the LogTag(s), the software will display the information for you. The chapter "Results from LogTag (on page 55)" explains in more detail the information that is displayed to you as a result of retrieving the recorded readings from LogTag(s).

Your LogTag may now also be reconfigured for another trip with the same settings as before, if you have this option activated.
Preparing LogTag(s) for use

Before you can use a LogTag to monitor and record environmental conditions you must first prepare it for use. The process of preparing a LogTag for use allows you to define a number of parameters, including:

- How long it should record the environmental condition for, so that you can be assured that it will record for the duration of time required. For example, if you want it to monitor a shipment that will take 10 days to deliver, you will be able to make sure it will record the humidity and/or temperatures throughout the entire 10 day period.
- How often it should record the environmental conditions.
- Under what conditions it should display an alert. An alert indicates when the environmental condition being recorded is not within set limits.

This chapter explains how to prepare a LogTag for use and what the options mean.

In This Chapter

Getting a LogTag ready for use ........................................... 30
Restricting Access .......................................................... 31
Preparing LogTag for next use ...................................... 32
Alert Processing ................................................................. 37
Advanced Alert Settings .............................................. 40
Display Logger Alarms .................................................. 43
Verify Access Password ............................................ 45
Pre-start data collection ................................................. 45
Continuous operation ...................................................... 46
Working with batches of LogTags .................................. 46
Getting the best from your LogTag ................................. 46
Configuration Profiles .................................................. 47
Quickly re-configuring LogTags .................................... 51
Automatic Re-Configuration after Download ............... 52
Hibernation - Prolonging battery life .............................. 52
Getting a LogTag ready for use

There are two ways to prepare a LogTag for use, both of which will achieve the same result. Once a LogTag has been through the configuration process to get it ready for next use, any readings previously recorded will no longer be available for retrieval.

- Click the LogTag icon ( dõi) on the toolbar or the "Wizard..." menu item located in the LogTag menu.

![Figure 15: Menu bar - LogTag Menu](image)

This is the safest option, as it will retrieve any readings that are stored within the LogTag and save them to disk before getting the LogTag ready for next use. This option is useful when you are unsure whether or not the readings stored within the LogTag have been previously retrieved and saved to disk.

- Click the "Configure..." menu item located in the LogTag menu.

This is the quickest option, as it does not involve the step that retrieves any readings that are stored within the LogTag. This option is useful when you know you have previously retrieved the readings or you no longer need a record of the readings that are currently stored within the LogTag.

The wizard will appear once you have selected the option of your choice to guide you through the necessary steps to prepare a LogTag for next use. While the wizard is visible the "Automatic download" feature will be disabled.
Restricting Access

Users can enable a password protection feature. Once enabled, a user will need to provide the correct password when next setting up the LogTag for recording.

![Password entry dialogue](image)

Figure 16: Password entry dialogue

A confirmation of this password is required.

**Tip:** Very often users tick the password required boxes, but don't enter a password. Such an "empty" password is valid, hence the password request dialogue will appear when re-configuring such a unit. In this case simply selecting OK will advance to the next screen.

Protecting Recorded Data

Various models offer the option to request a password also when the logger is downloaded. This function can be enabled when configuring the logger by ticking the box next to "Download requires password":

![Password options](image)

Some models do not have this feature enabled, but can be upgraded. In this case a further check box appears on the configuration screen:

![Password options](image)

The check box "Download requires a password" is greyed out if the update has not previously been applied to the logger being configured. Once you select the "Update logger to enable this feature" box, the "Download requires a password" box becomes available for activation. You can then select the password functions for either configuration or download. The logger will be permanently upgraded as soon as the configuration is applied.

Following should be noted:

- The update cannot be reversed.
- If the "Update logger to enable this feature" is selected, the upgrade will perform, regardless whether any of the "...requires a password" tick boxes are enabled or not.
- If multiple units are configured at the same time using more than one interface, all units will be upgraded if the Upgrade option is selected.
- If this upgrade is applied, LogTag Analyzer 1.8r9 or later will be required to access the loggers. Older versions will display an error message if communication is attempted.
- When the "Again" button is used with a different unit, that unit will also be upgraded.
- Data files cannot be protected by passwords.
- If a unit has been upgraded in a previous session, and is now configured using the "Download requires a password" function, units configured with the "Again" button in the same session will not automatically be upgraded; only those units that have already been upgraded separately in a previous session will have the "Password on download" function enabled.

**Password Rules**

The password can be up to 6 characters long and can contain a mix of letters, numbers and special characters. The selected input language of the computer's operating system determines which special characters can be selected.

If a user decides to make use of special characters, extra information about the language used is stored inside the recorder. Users will then need LogTag Analyzer 2.3 Release 7 or later so the password is correctly interpreted.

If you use special characters for languages such as Japanese or Chinese the maximum number of characters that can be used will be reduced due to the increased memory required to store the characters.

Please see Code Pages on page 152 for a more detailed explanation.

**Preparing LogTag for next use**

The "Configure LogTag(s) for next use" step provides you with all the options that can be configured to affect how a LogTag records data during its next use. This screen is automatically presented when you use the wizard, however, you can also configure LogTags by clicking `Configure` from the LogTag menu.
When you have entered the details and adjusted the settings as desired, click Next to send the configuration information to the LogTag(s).

The following table describes each configurable option that is permitted to change.

<table>
<thead>
<tr>
<th>Function</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>User ID</td>
<td>This can be used for identification of the load in transit to be monitored, or simply an identifier that describes the purpose of the monitoring. Bill of Loading information, Shipper, commodity, contact name and other relevant information can be placed here. The User ID can be up to 38 characters long (36 for recorders with a display) and can contain a mix of letters, numbers and special characters. The selected input language of the computer's operating system determines which special characters can be selected. If a user decides to make use of special characters, extra information about the language used is stored inside the recorder. Users will then need LogTag Analyzer 2.3 Release 7 or later so the User ID is correctly displayed. If you use special characters for languages such as Japanese or Chinese the maximum number of characters that can be used will be reduced due to the increased memory required to store the characters. Please see Code Pages on page 152 for a more detailed explanation.</td>
</tr>
<tr>
<td>Start method</td>
<td>This is used to determine how/when the LogTag will start recording its next set of readings.</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td><strong>Push button start</strong>[]When the 'Push button start' option is selected, the LogTag will start recording when the START MARK button has been pressed and held until both the OK and Alert lights alternately flash on and off. If pre-start recording is enabled, the LogTag will start logging pre-start readings immediately (see section &quot;Pre start data collection on page 45&quot;).</td>
</tr>
<tr>
<td></td>
<td><strong>Date/Time start</strong>[]When the 'Date/Time start' option is selected, the LogTag will automatically start recording at the date/time defined in the subsequent field. Pressing the START MARK button prior to the start date/time will have no effect. There will be no pre-start readings recorded prior to the start date/time. Note: When using the Date/Time start option, the earliest start time that can be selected is two minutes after the current time. This delay allows you to complete the remaining configuration options and gives the software enough time to configure the LogTag before it starts.</td>
</tr>
<tr>
<td></td>
<td><strong>Push button start from hibernation</strong>[]When the 'Push button start from hibernation' option is selected, the LogTag will start as if programmed for 'Push button start'. The difference is that once the configuration is successfully downloaded to the LogTag it will be placed into hibernation. When the START MARK button has been pressed and held, the LogTag will wake from hibernation and start recording with the parameters as configured. Please note in this mode the real time clock inside the logger is not active. It is therefore vital that the computer on which the unit is downloaded is set to the correct time. Please see Prolonging battery life (see &quot;Hibernation - Prolonging battery life&quot; on page 52) for more information on Hibernation. Not every LogTag model can support every start mechanism. As a result, specific options may not be be listed when configuring a LogTag.</td>
</tr>
</tbody>
</table>

| Enable pre-start logging | Pre-start logging is a feature that protects the recording in the event of a failure to actually press the START MARK button to initiate the recording. It is an insurance policy against the loss of critical data. This is almost always checked for transit monitoring applications. This option is further explained in the section Pre start data collection on page 45. |
| Record readings continuously, overwrite oldest when memory full | This is what is called a "data wrap" in which the recorder just keeps writing data to memory. It is a "moving window" of data. For example, this is useful for fixed base MKT monitoring with the interval set to one year, so that the current "yearly MKT" can always be in the memory of the LogTag. If this option is selected, the user will be "opted out" of the next two options. This option is further explained in the section Continuous operation (on page 46). |
| Record readings so that: | If this is selected, the logger stops logging when the number of data points has been gathered and stored in memory that spans at least the number of days specified below. When this option is selected, the following two options will determine the number of data points over the span of time that will be recorded. |
| Readings recorded will span at least X days | If you know how long you want to record, the Configuration screen will automatically set the number of readings to be collected at a particular interval. This setting will only have an effect if the above option "Record readings so that:" is selected.
| **Number of readings to record X maximum is Y** | This data box will display the calculated number of readings if you select a time span and an interval. Alternatively, you can select the number of readings desired, and the time span will be altered based on the interval. If this is selected, the logger will stop logging when the number of readings has been gathered and stored in memory. "Y" represents the maximum number of readings the LogTag can store, however with a selected interval and a selected time span, you may not need to use all of the available data space. This setting will only have an effect if the above option "Record readings so that:" is selected. |
| **Record a reading every X** | This determines how frequently the LogTag records the environmental humidity and/or temperature into its internal memory. |
| **Begin recording after a delay of X** | Determines how long after the START MARK button on the LogTag has been pressed that it will actually begin to record the environment humidity and/or temperature. This feature is useful for example, when the LogTag could falsely trigger an alert because the environmental conditions it is being started in is quite different to the environmental conditions to be monitored. If pre-start logging is enabled, the LogTag will continue to record pre-start readings during this delay. |
| **Enable the OK (Green) indicator** | This determines whether or not the green light should function while the LogTag is recording after being started. |
| **Humidity / Temperature** | These tab controls will allow the humidity and temperature alert conditions to be configured independently. These tab controls will only appear when configuring a LogTag that has a humidity and a temperature sensor. If the LogTag has only one sensor then the following alert conditions will apply to that sensor. |
| **Configure requires a password** | This feature allows the user to define a password that must be provided (see "Restricting Access" on page 31) to configure the LogTag next time. If this option is enabled and the password changes, the user will be required to verify the new password (see "Verify Access Password" on page 45) when the wizard progresses to the next step. Passwords are case sensitive and therefore the passwords "Bob" and "bob", for example, are different. |
| **Download requires a password** | If this option is enabled, the LogTag's recorded data can only be downloaded after entering the correct password. **Note:** Only one password can be provided for each LogTag. The same password applies to the Configure and Download actions. |
TRIX-8, TREX-8 and TREL-8 loggers which do not yet have the "Download requires a password" feature can be upgraded. These units will then require LogTag Analyzer revision 1.8r9 or later to be configured or downloaded, and an error message will be displayed in older versions.

If LogTag Analyzer configures such a logger, an additional check box is displayed:

<table>
<thead>
<tr>
<th>Configure requires a password</th>
<th>Upgrade logger to enable this feature</th>
</tr>
</thead>
</table>

The "Download requires a password" is grayed out if the update has not previously been applied to the logger being configured. Once you tick the "Update logger to enable this feature" box, the "Download requires a password" check box becomes available for activation. You can then select the password functions for either configuration or download. The logger will be permanently upgraded as soon as the configuration is downloaded.

**Note:**
- The update cannot be reversed.
- If the "Update logger to enable this feature" is ticked, the upgrade will perform, regardless whether any of the "...requires a password" tick boxes are enabled or not.
- If multiple units are configured at the same time using more than one interface, all units will be upgraded if the Upgrade option is selected.
- When the "Again" button is used with a different unit, that unit will also be upgraded.

**Note:** If a unit has been upgraded in a previous session, and is now configured using the "Download requires a password" function, units configured with the "Again" button in the same session will not automatically be upgraded; only those units that have already been upgraded separately in a previous session will have the "Password on download" function enabled.

If the battery within the LogTag is detected to be low and therefore not recommended for further use, the software will display a warning to you in the top right corner, like the following example.

![LogTag battery low](image)

Some LogTag® models display the remaining percentage in this screen once it falls below half capacity. Some models cannot be configured any longer once their battery capacity falls below a pre-determined threshold.
Alert Processing

The LogTag can display a visual alert if one or more of the configured alert conditions have been met. An alert condition can be a single alert reading (a reading outside of or including the upper and lower threshold values), a combination of consecutive alert readings or a total of alert readings encountered during the trip.

The threshold parameters are identified in LogTag Analyzer when the LogTag’s readings are downloaded and displayed.

Please note that matching these to known conditions of interest in your monitoring program may require some information about the effects of exposure to different durations of out-of-range humidity and/or temperatures.

As with the other logging parameters these are adjusted in the "Configure LogTags for use" screen.

The following table describes each configurable option.

<table>
<thead>
<tr>
<th>Function</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable the Alert (Red) indicator when</td>
<td>This determines whether or not the red light should activate when an alert condition has been detected. An alert occurs when one or more of the conditions described below have been met. When an alert condition has occurred, this indicator will flash at a regular interval.</td>
</tr>
<tr>
<td>Readings below X or above Y (inclusive)</td>
<td>You can set the upper threshold limit and lower threshold limit by entering the appropriate information in the boxes. If readings stay inside the range specified by X and Y the alert indicator will not activate. If a reading of X and below, or Y and above is recorded, the alert indicator may light up, dependent on the alert conditions. Charts will display alert readings according to the settings made in the Charts (on page 106) section of the 'Options' Screen. <strong>Note:</strong> The values entered in these boxes are included in the alert range. In the above example 7 consecutive readings of 45°C will trigger an alert, whereas 7 consecutive readings of 44.9°C will not trigger an alert. Please set your alert values with this in mind.</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>After X consecutive alert readings</td>
<td>Tick this box, and enter a number into the adjacent field if you want to trigger an alert condition once X number of consecutive alert readings are recorded. Note that the number of minutes shown will depend on the number of alert readings you enter into the box AND the recording interval already specified. For example, if X is 3 and two readings are above the upper threshold limit but the subsequent reading is below the upper threshold limit and still above the lower threshold limit then the alert indicator will not activate. Maximum value is 256, minimum is 2.</td>
</tr>
<tr>
<td>After X alert readings have occurred</td>
<td>Tick this box, and enter a number into the adjacent field if you want to trigger an alert condition once a total number of alert readings have been recorded, regardless of whether they are consecutive or not. Maximum value is 256, minimum is 2. You can increase or decrease the values with the arrows next to the fields. Please note these are linked and certain combinations may not be allowed.</td>
</tr>
<tr>
<td>Leave alert indicator enabled even if</td>
<td>If this option is enabled then the alert indicator will remain active, even if the current reading does not meet the alert conditions specified by the previous controls. If this option is disabled then the alert indicator will remain active only if the current reading meets the alert conditions specified by the previous controls. Please note, however, that this setting is only applicable if an immediate alert is configured; if consecutive or accumulative alert settings are configured this box has no effect, and the alert indicator will always remain visible once an alert has occurred.</td>
</tr>
<tr>
<td>readings return within alert range</td>
<td>Clear and reset alert when START MARK button pressed</td>
</tr>
</tbody>
</table>

Once the LogTag has finished recording, pressing the START MARK button will not clear and reset any active alert.
Example:

You wish to configure a LogTag so alert conditions are indicated if 5 continuous readings are out-of-range or 7 total readings are out-of-range. Alert parameters should be set as follows:

<table>
<thead>
<tr>
<th>Box 1</th>
<th>Box 2</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>After</td>
<td>5</td>
<td>consecutive alert readings (5 Minutes)</td>
</tr>
<tr>
<td>After</td>
<td>7</td>
<td>alert readings have occurred (7 Minutes)</td>
</tr>
<tr>
<td>Leave alert indicator enabled even if readings return within alert range</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

This table shows how different conditions would result in the Alert Indicator flashing or not:

<table>
<thead>
<tr>
<th>What the LogTag recorded</th>
<th>What the LogTag indicated</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 readings out-of-range, return to normal, 2 readings out-of-range, return to normal</td>
<td>Neither alert condition is met. The maximum number of consecutive out-of-spec readings is only 2 (5 required.) The total out-of-range events equals 2 + 2 + 2 = 6. The alert condition is 7 total, so the alert does not go off. <strong>No Flashing Red Alert Indicator</strong></td>
</tr>
<tr>
<td>4 readings out-of-range, return to normal, 4 readings out-of-range</td>
<td>The first alert condition is not met, as the maximum number of consecutive alert condition readings is only 4 (5 required.) The second alert condition however IS met since the total alert condition readings equals 4 + 4 = 8. The alert condition is 7 total, so the alert DOES go off. <strong>Flashing Red Alert Indicator</strong></td>
</tr>
<tr>
<td>4 readings out-of-range, return to normal, 2 readings out-of-range</td>
<td>Neither alert condition is met. The maximum number of consecutive alert condition readings is only 4 (5 required.) The total number of alert condition readings equals 4 + 2 = 6. The alert condition is 7 total, so the alert does not go off. <strong>No Flashing Red Alert Indicator</strong></td>
</tr>
<tr>
<td>6 readings out-of-range, return to normal</td>
<td>The second alert condition is not met, as the total out-of-range events equals 6 (7 required.) The maximum number of consecutive alert condition readings however is 6, the alert condition is 5 consecutive readings, so the alert DOES go off. <strong>Flashing Red Alert Indicator</strong></td>
</tr>
</tbody>
</table>

Please note following special conditions:

1. If you wish an alert to be indicated on the first reading that is recorded out-of-spec, place a tick in the box next to "Enable the Alert (Red) indicator when" and remove the ticks in both boxes next to the "After X consecutive alert readings" and "After X alert readings have occurred".
2. You cannot enter a number into the "After X consecutive alert readings" field which is larger than the number in "After X alert readings have occurred", since the latter alert condition would always be met first.

3. Similarly, you cannot enter a number into the "After X alert readings have occurred" field which is smaller than the number in "After X consecutive alert readings". The software will adjust field values as appropriate.

### Advanced Alert Settings

Some LogTags support more detailed alert settings than described before. If LogTag Analyzer encounters one of these loggers, an additional button is visible in the bottom left of the configuration screen.

When this button is pressed, the alert configuration screen changes and displays additional settings:

![Alert Configuration Screen](image)

The red alert indicator can now be configured independently for upper and lower alert values.

<table>
<thead>
<tr>
<th>Function</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Readings above X</td>
<td>In addition to entering the threshold levels, tick the boxes next to &quot;Readings above&quot; or &quot;Readings below&quot; to enable the alert conditions for only the upper or only the lower threshold settings, or for both. If both boxes are ticked, the behaviour is the same as for the standard alert settings. The charts will display alert readings according to the settings made in the [Charts](on page 106) section of the ‘Options’ Screen.</td>
</tr>
<tr>
<td>Readings below Y (inclusive)</td>
<td></td>
</tr>
<tr>
<td>After X consecutive alert readings (W minutes)</td>
<td>Tick the boxes next to &quot;Readings above&quot; or &quot;Readings below&quot; to establish whether only readings above and including the upper threshold or only readings below and including the lower threshold should count towards the consecutive alert readings. If both boxes are ticked, the behaviour is the same as for the standard alert settings. If the Alert Indicator is disabled for either the upper or the lower alert, the respective box for the consecutive alert is grayed out and cannot be ticked.</td>
</tr>
</tbody>
</table>
Preparing LogTag(s) for use

After X alert readings have occurred (W minutes)
Readings above
Readings below

Tick the boxes next to "Readings above" or "Readings below" to establish whether only readings above and including the upper threshold or only readings below and including the lower threshold should count towards the total number of alert readings. If both boxes are ticked, the behaviour is the same as for the standard alert settings. If the Alert Indicator is disabled for either the upper or the lower alert, the respective box for the alert total is grayed out and cannot be ticked.

The advanced settings are displayed automatically without the need to press [Advanced >>] if an advanced configuration is already found in the logger to be configured. If you do not wish to use the advanced settings, press [<<Cancel], and the standard Alert Processing (on page 37) configuration screen is displayed.

Example:

You wish to configure a LogTag so an alert is displayed if 5 continuous readings are out-of-range or 7 total readings are out-of-range, but only if the temperature goes to 20ºC and above. You wish to see in LogTag Analyzer if the product has gone to 0ºC and below, but you do not wish to trigger an alert for this condition. Alert parameters should be set as follows:

This table shows how different conditions would result in the Alert Indicator flashing or not:

<table>
<thead>
<tr>
<th>What the LogTag recorded</th>
<th>What the LogTag indicated</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 readings of 20ºC or above, return to normal, 8 readings at 0ºC or below, return to normal, 4 readings of 20ºC or above, return to normal</td>
<td>Neither alert condition is met. The maximum number of consecutive out-of-spec readings is only 2 (5 required, the 8 readings below 0ºC do not count towards alert readings). The total out-of-range events equals 2 + 4 = 6. The alert condition is 7 total, so the alert does not go off, as again the 8 readings below 0ºC do not count towards alert readings. <strong>No Flashing Red Alert Indicator</strong></td>
</tr>
<tr>
<td>4 readings of 20ºC or above, return to normal, 4 readings of 20ºC or above</td>
<td>The first alert condition is not met, as the maximum number of consecutive out-of-spec readings is only 4 (5 required.) The second alert condition however IS met since the total out-of-range events equals 4 + 4 = 8. The alert condition is 7 total, so the alert DOES go off.</td>
</tr>
</tbody>
</table>

**Flashing Red Alert Indicator**

Separate alert conditions are useful if you expect the monitored product to encounter temperatures lower than the lowest possible alert temperature. In this case a flashing alert indicator may not necessarily indicate an unfavourable condition was encountered. In programs where such conditions are monitored the lower alert should be turned off.
Display Logger Alarms

TRID30-7 and TRED30-7 loggers have a different settings screen.

The settings are similar to the Advanced Alert Settings on page 40, hence they are not explained again here. There is however one notable exception; for each range (above or below) you can only select either accumulative or consecutive readings, but not a combination of both. This does however give you the option to select e.g. a different number of cumulative readings for above and below ranges.

In this screen you can also see an button. When clicking this button, following configuration screen is displayed, allowing you to enter parameters specific to TRID30-7 and TRED30-7 loggers.
<table>
<thead>
<tr>
<th><strong>Function</strong></th>
<th><strong>Purpose</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear and reset alarm when STOP/CLEAR button pressed</td>
<td>If this option is enabled, any user can turn off an active alarm directly on the LogTag by pressing the STOP/CLEAR button. This will turn off the alarm symbol and reset the internal counters as if no alarm had occurred while the LogTag was recording. When the LogTag subsequently registers a further alarm condition, the alarm will activate again. Once the LogTag has finished recording, pressing the STOP/CLEAR button will not clear and reset any active alarm.</td>
</tr>
<tr>
<td>Alarm remains on even if readings return to non-violation range</td>
<td>If this option is enabled then the alarm symbol will stay on, even if the current reading does not meet the alarm conditions specified by the previous controls. If this option is disabled then the alarm symbol will stay on only if the current reading meets the alarm conditions specified by the previous controls.</td>
</tr>
<tr>
<td>Pause alarm/statistics processing for X readings</td>
<td>If this option is enabled, pressing either button on the LogTag while recording excludes the next reading from the alarm and statistics calculations; PAUSED will now be shown on the display. This allows the user to review the statistics or clear an alarm without causing an invalid reading, alarm or statistic.</td>
</tr>
<tr>
<td>Switch off display after 30 seconds</td>
<td>If this option is enabled, the display will turn off after 30 seconds to save battery power.</td>
</tr>
<tr>
<td>Allow logging stop with STOP button</td>
<td>If this option is enabled, the LogTag can be stopped by pressing the STOP button. The recorder will no longer take any readings, however you can still review the day statistics and download the logged results to a PC with LogTag Analyzer.</td>
</tr>
<tr>
<td>Allow reset of logger with START button</td>
<td>If this option is enabled, TRID30-7 and TRED30-7 loggers can be re-activated and used again for a new trip by pressing the START button. <strong>When re-activating the recorder, all previously recorded readings and statistics will be erased!</strong> When this option is enabled, a warning box will be displayed to remind you this is enabled and can result in loss of data.</td>
</tr>
<tr>
<td>Show total summary days collected</td>
<td>If this option is enabled, the LogTag shows the number of days for which statistics have already been collected on the display.</td>
</tr>
</tbody>
</table>

Please refer to the LogTag® product specification & guide documents for TRID30-7 and TRED30-7 recorders on the LogTag Recorders website at http://www.logtagrecorders.com for a detailed description of the functionality of these products.
Preparing LogTag(s) for use

Note: When referring to TRID30-7 and TRED30-7 products, versions with both the fixed (F-suffix) and replaceable (R-suffix) battery are included.

Verify Access Password

If the "Configure requires a password" on page 29" option was enabled or the password was changed during the configuration process the user is required to verify the password before it will be stored in the LogTag. A window similar to this will appear:

![Verify new password window]

Once a password has been stored in the LogTag, further access to it can only be achieved by providing the correct password. Therefore, if a password is forgotten further access to the LogTag will not be possible. Passwords are case sensitive and therefore the passwords "Bob" and "bob", for example, are different.

Pre-start data collection

The LogTags support a feature called "pre-start logging", which can be selected during configuration.

When pre-start logging is enabled the LogTag will automatically start logging as soon as configuration is completed. It will record at the same sampling interval as defined in the configuration and will continue to record until the user starts the LogTag by pressing the START MARK button on the LogTag. Once the LogTag has been started, it will record as per the configuration settings. While the LogTag is recording pre-start readings the Alert LED on the LogTag will not activate if an alert condition is detected.

Pre-start logging is useful as a fail-safe recording setting so if the LogTag is not started at the appropriate time, the readings will still be available to view later.

When the readings are retrieved from the LogTag, any pre-start readings will be identified as pre-start readings so the user can quickly identify the readings recorded before and after the LogTag was started.

All LogTags have a finite amount of memory to store the readings it records. Therefore, while the LogTag is recording pre-start readings the LogTag will operate in its 'continuous operation' mode, which is explained further in the section "Continuous operation (on page 46)". Once the
memory within the LogTag is full the oldest pre-start reading will be overwritten with the latest reading recorded, regardless of whether the reading recorded is a pre-start reading or a reading to be recorded after the LogTag has been started.

If a LogTag has been configured to start recording at a certain date/time, or for push button start from hibernation, no pre-start readings will be recorded.

Continuous operation

All LogTags have a finite amount of memory to store the readings that are recorded. When the LogTag is recording readings continuously it will not stop once the memory within the LogTag is full of readings. Rather it will replace the oldest reading stored within the LogTag with the latest reading so that only the most recent readings are maintained in the LogTag's memory.

If the LogTag being configured does not support this feature, you will not be able to select this setting.

Working with batches of LogTags

You may find that at some stage you need perform a similar task on multiple LogTags, whether it is retrieving readings stored within the LogTags and/or preparing them for their next use. The LogTag Analyzer software has been designed to make the effort involved with multiple LogTags as simple as possible.

To retrieve a copy of the recorded readings stored within multiple LogTags, simply insert each LogTag to download into the Interface cradle. The software will then automatically retrieve the recorded data from the LogTag, save it to disk and then display the information for you. Therefore, you will be able to retrieve the recorded readings stored from within one or more LogTags without needing to interact with the software and/or computer.

To prepare multiple LogTags for use you can use the "Wizard..." or the "Configure..." wizard, available in the "LogTag" menu, depending on whether or not you want to retrieve and save a copy of any readings recorded within the LogTags you are about to use. Simply prepare the first LogTag(s) as per usual and at the conclusion of the last step remove the LogTag(s) from their Interface Cradle, place the next LogTag(s) to be prepared for their next use into an Interface Cradle and click . Therefore, you will be able to prepare multiple LogTags for use with minimal interaction with the software and/or computer.

Getting the best from your LogTag

Many users of humidity and/or temperature loggers are used to attaching the logger to a hook or tie-wrapping them to a monitored object. A wide variety of attachment methods can be used with the hole on upper right hand corner of the LogTag, such as bolting the LogTag in position, attaching it to a packaging strap, using a car-seal for security or other means.
Preparing LogTag(s) for use

The hole is quite strong, so most means of attachment will not compromise the structural integrity of the LogTag. We do, however, recommend that the dead weight stress on the hole itself not exceed 5 pounds (2 Kg).

The sensor for the LogTag is also very responsive, so we recommend you position the LogTag in a location, where it will not be susceptible to changes in temperature due to operational activities. For example, it is not recommended you place a LogTag beside a door way, as every time someone passes through the door, the LogTag will register the change of environmental temperature due to the breeze that will be generated by the person, which does not necessarily reflect the overall temperature of the environment been monitored.

Configuration Profiles

Starting with version 2.2 LogTag Analyzer provides a great way to make the task of configuring loggers over and over with the same parameters a lot simpler.

For every logger type multiple configuration profiles can be stored and retrieved later. These configuration profiles hold information such as alert limits, logging interval, number of readings to record and most of the other parameters you would typically enter during configuration.

Configuring a logger with a given profile requires only three steps:

1. Access the "Profiles" function from the LogTag menu
2. Select the profile you wish to use in the Configuration Profiles main window
3. Click on configure

The "Configuration Profiles" window is accessed through the LogTag menu by selecting Profiles.
The window that is now displayed gives you an overview of the profiles already installed as well as some controls so you can add, edit and delete profiles.

Figures 17 and 18 illustrate the various components of the profile main window and profiles grid respectively. The tables below list the functions of each button and control:

Profiles Grid

When you first select this feature the profiles grid will be empty (just like above). You will fill the grid by adding profiles or importing profiles.

Profiles from the grid can then be used to configure loggers. A single click on the column title will sort the profile using this column. Double clicking on a profile will configure all loggers currently in connected interfaces using the parameters stored in the configuration profile. You can select multiple profiles for export or deletion when you hold down the \texttt{CTRL} key while clicking, but you cannot edit or apply more than one profile at the same time.

Profile Control Buttons

Selecting the "Configure loggers" button will configure all loggers currently in connected interfaces using the parameters stored in the configuration profile highlighted in the grid (this is the same as double clicking on the profile name).

Use the control buttons to add new profiles, and to edit or delete existing profiles.
Clicking the button will bring up the "Edit Profile" window.

![Edit Profile Window]

**Figure 19: New Profile Window**

1. Profile name
2. Recorder model
3. Configuration parameters

This window contains all the controls you can find in the configuration window, plus one entry field at the top where you need to enter the new name of the profile, and a drop down box where you need to select the model type of the logger.

The same window will be displayed when you press the button. Every entry field is now populated with the saved value for this profile. Any entry field can be edited, with the exception of the model type.

You can click to save the profile, to discard any changes, and also bring up the help screen for this window by selecting .

**Profile Storage File Name and Path**

The collection of profiles displayed in the profiles grid is saved in a single file on your PC, which is called the profile file. This file is typically stored in a folder called "LogTag Configuration Profiles" inside the "My LogTag Data" folder. Every time you open LogTag Analyzer this profile file is activated.

You can select alternative collections by opening different files. This can be useful if for example you want to keep different profiles for different customers, or you prefer to separate and organise your profile collections.

You can click on the button and select a different profile file. If you have unsaved changes you will be asked to confirm if you want to first save these changes. An explorer window will then open, where you can select a new profile file.

Note: To create a new profile file, export one or more profiles to a new profile file. You can then open the new profile file and add, edit or delete profiles as usual. Alternatively, you can
download an empty profile file template from

Profile File Controls

If you have stored your profiles in different profile files, you can transfer data between different files with the import and export buttons.

When you click on the **import** button, an explorer style window will open. Select the profile file from which profiles will be imported and confirm your selection by clicking on **open**. All profiles from the selected profile file will be imported into the currently active profile. If a profile is imported that has the same name as an already active profile, you need to confirm whether you wish to skip the import of this profile or overwrite the active profile with the imported profile.

You can export selected profiles to a new file by highlighting a profile and clicking the **export selected** button. An explorer style window will open, where you can enter a new profile file name (the file will be created when you press **save**), or overwrite an existing profile. If a profile is exported, and a profile file already exists, you need to confirm whether you wish to cancel the export of this profile or overwrite the profile file. You can export more than one file at the same time by selecting the desired files while holding down the **CTRL** key.

You cannot amend a profile file by exporting a profile.

Profile Window Controls

Clicking **save changes and exit** will store the profile in the location entered above. Clicking on **cancel** will discard any changes and return you to the main window.

Please note there are some restrictions when you work with configuration profiles:

| Configuration profiles cannot use the date/time start mechanism. If a defined start time were to be applied to a profile, this time would most likely have passed by the time the profile is applied. If you need to configure a number of loggers and you want them all to start at the same time you should use the standard configuration screen and the Again button.  
You cannot configure one type of logger model with a profile written for another model.  
You cannot have multiple profiles with the same name.  
If you have exported a profile to a profile file, cancelling the main edit window will not undo the changes.  
If you try to apply a profile to a recorder with a password protected configuration, this same password must be provided in the profile. There is no separate password confirmation dialogue.  
Loggers that can be upgraded to use a download password will automatically be upgraded when a profile is applied using this feature.  

Sometimes a logger cannot be configured using a particular profile. In this case one of the following errors will be displayed:  

"Logger does not support advanced alert settings" You have selected a profile which has separate upper and lower alert settings, but the logger you wish to configure does not support this. You will need to use a different profile, or use a different logger if this feature is important for this trip.
"Logger cannot record more than X readings" You have selected a profile that requires the logger to take more readings than fit into its memory. You will need to use a different profile, or use a different logger if this feature is important for this trip.

"Password in profile does not match logger password" You have selected a profile with a password, and the password currently stored in the logger is different. You will need to use the normal configuration process to remove the password; after that you can use the profile function to configure the logger with the new password. If the logger does not allow the password to be changed, you will need to use a different profile.

"A password cannot be applied to this logger" You have selected a profile with a password, but the logger is factory configured so the user cannot change or enter a password. You will need to use a different profile that doesn’t have a password protection, or use a different logger if this feature is important for this trip.

"Logger only supports latched master alarm" Loggers typically can have a setting applied that allows an alarm to reset if conditions go back to within specification. Some older TRID30-7 loggers do not support this feature, and if you attempt to configure such a logger with a profile using this setting you will see this error. You will need to use a different profile or use a later model TRID30-7 if this feature is important for this trip.

"Profile logger type does not match" You are trying to configure a unit with a profile that was created for another model. A profile is specific to a logger model, so you will need to use a different profile.

"Lease expired. The max. number of starts has been reached." You are trying to configure a unit which has no more trips left. You will need to use a different logger.

Quickly re-configuring LogTags

You can now configure a LogTag® recorder without first displaying the configuration screen. To do this, you can use the "Quick Re-Configure" function from the LogTag menu, and you will see the "Upload configuration" screen where a recorder will simply be re-configured with the settings used for the previous trip.

![Quick Re-configure option through menu](image)

You can also use the "F6" function key.

There are certain rules when using this function:

- You can use multiple interfaces. Each LogTag detected in an interface is re-configured with the same data used for its previous trip. Recorders do not have to be of the same model, and can each have different configuration settings.
- Re-configuration is only possible for recorders which used the "Push button" or the "Push button from hibernation" start method for their previous trip. If the recorder's previous trip was started by the date/time start method the quick re-configure option will result in an error message being displayed.
• If a recorder requires a password for configuration you will be requested to provide this password. If you enter an incorrect password, the configuration process will be aborted.
• If the LogTag is still logging when you reconfigure it, you will be asked to confirm whether or not you wish to stop the current trip.

### Automatic Re-Configuration after Download

To re-configure a recorder even faster you can now use the "Re-configure with same settings after automatic download" option.

When you have enabled this option in **EDIT - OPTIONS - AUTOMATION**, a LogTag is automatically re-configured with the same settings as the trip just completed once its data have been downloaded (see Automation on page 107). You will receive the following feedback once the configuration is complete:

![Feedback](image)

Please note this option only works when a LogTag is automatically downloaded when inserted into the interface, i.e. the "Enable automatic download of readings from LogTags" option must be enabled, and the download triggered by inserting the recorder into the interface. This does not apply when the LogTag is downloaded through the menu of by pressing F4.

A word of caution: If the LogTag you have downloaded does not have a configuration password and has also finished logging, the only visual feedback on the PC will be after the recorder has already been re-configured for a new trip. You will only be able to access the data from the trip just downloaded on the PC, but not within the recorder. Therefore it is important you make sure the file location for storing data is always accessible to avoid loss of data.

### Hibernation - Prolonging battery life

If your LogTag is not going to be used for extended periods of time, you should set it to "Hibernation". While in "Hibernation" the LogTag will consume minimal power, which will extend the battery life when compared with leaving an idle LogTag operating.

While a LogTag is in "Hibernation" it will:

• Not record and store any new readings.
• Not activate the Alert and OK lights.
• Not respond to the START MARK button being pressed.
Preparing LogTag(s) for use

The only exception is when the LogTag has been configured for 'Push button start from hibernation' in the configuration screen. In this case pressing the START MARK button will 'wake' the product and commence logging according to the configured settings. Not every model supports this feature.

To 'wake' a LogTag from "Hibernation" to normal operation go through the usual process of preparing it for next use (see "Preparing LogTag(s) for use" on page 29).

To set a LogTag to "Hibernation", select HIBERNATE... from the LOGTAG menu.

You can also use the F5 function key.

The following example illustrates using the "Hibernation" feature.

In this screen you will see one of the following pictures next to each of the items in the list:

- (no picture) indicates the LogTag is still in the process of being hibernated.
- ✓ The LogTag was successfully set to hibernation.
- ✗ The software was unable to set the LogTag to hibernation.

Once a LogTag has been successfully set to "Hibernation" it should be removed from the Interface Cradle before pressing any other button. As soon as the software communicates with a LogTag in "Hibernation", (for example through automatic download it will be returned to normal operation.

The extent to which the Hibernation will prolong the battery life of a LogTag may vary between different models and versions of LogTag products. Some LogTag models may not support Hibernation.
For most LogTags you will want to view the recorded information once a trip has been completed. For this, you can use the LogTag Analyzer software and an Interface Cradle to transfer the information from the LogTag to a PC. The software will automatically save any downloaded trip information retrieved from a LogTag to your disk drive so that you can view the information and archive it.

This chapter explains how you can retrieve the recorded information and have the software display it to you on the screen in a meaningful way.

In This Chapter

Getting results from LogTag........................................... 56
Saving LogTag Data ..................................................... 57
Analysing the results ................................................... 62
Combining charts onto a single chart ......................... 80
Automatically calculated statistics .............................. 87
Displaying statistics ..................................................... 93
Printing the results ...................................................... 94
Sending a file by e-mail direct from Analyzer ............. 95
Calling up previous results ......................................... 96
Digital signatures ....................................................... 97
How secure is my data ............................................... 99
Viewing file properties .............................................. 100
Getting results from LogTag

LogTag products store all readings in non-volatile memory. You can retrieve the recordings as many times as you require, as long as the recorder is not re-configured. The process of retrieving data stored within a LogTag does not in itself erase the data from the LogTag’s memory, however if you have turned on the "Automatically re-configure..." option you will no longer be able to access the data inside the recorder once this process has finished; rather you must rely on the stored file to access such data.

If the LogTag is currently recording while you retrieve the information, it will continue to record without interruption. If the recorder is in the process of taking a log you may see a slightly longer download time as communication pauses to allow the log to be taken.

There are three ways to retrieve the recorded results from a LogTag:

- Slot the LogTag into the interface cradle while the LogTag Analyzer software is running (this can be in the background, or even minimized). If the automatic download feature is enabled, the software will automatically retrieve the recorded readings, save the information to your disk drive and display the information to you. While the software is automatically retrieving the readings you will see an animation, similar to the following picture.

  ![Figure 22: Downloading a LogTag Recorder](image)

- Click **DOWNLOAD...** from the **LOGTAG** menu.

  ![Menu Options](image)

  You can also press the **F4** function key.

- Click the LogTag icon (строен) on the toolbar or click on **WIZARD...** from the **LOGTAG** menu.

  The wizard will guide you through the necessary steps to retrieve the readings stored in the LogTag and then offer to prepare the LogTag for its next use. If you do not need to configure the LogTag at this time you can cancel the process, however if you do not intend to configure units directly after downloading you may find it quicker to use the previous option.

  **Note:** While the wizard is visible the "Automatic download" feature will be temporarily disabled. You will not be able to access any of the Wizards while an "Automatic download" is in progress.
Saving LogTag Data

Saving LogTag Data files

Every time you download a LogTag Recorder to your computer the data are automatically saved to a file with a *.ltd file extension (LogTag® Data). This type of file is unique to LogTag data loggers and can only be read by LogTag Analyzer software.

You can customise the conditions for which the file is generated in the Edit - Options window:

- You can determine the file's name by specifying the key details about the logger it was downloaded from (File Name on page 119)
- You can decide if existing files with older data should be overwritten or kept (Uniqueness on page 122)
- You can automatically have files sent to e-mail recipients and FTP sites (Automation on page 107)
- You can decide which additional other file formats are created (Exports and Reports on page 123)

You can also save all or part of the data in other files to make them accessible to other users (Selected LogTag® files on page 58 and PDF files on page 60).

Please refer to the respective sections in this user guide for more information.

Saving a Multi Chart file

If the main LogTag Analyzer window currently displays a Multi Chart as explained in Combining charts onto a single chart (on page 80), you can save the current configuration by clicking on the toolbar icon or selecting Save from the File menu (on page 131). Select a file name and location for your Multi Chart file. The file extension for Multi Chart files is "*.multi".

A Multi Chart file does not contain any recorded data. Instead, it contains a collection of information that describes which data files need to be opened, and in which relation to each other the data inside these files should be displayed, such as chart colors and time offset when Shifting chart start times (see "Combining charts onto a single chart" on page 80).

Therefore, if any of the data files referenced in a Multi Chart file are renamed, deleted, or moved to a different folder, this Multi Chart file will display error messages.

A Multi Chart file must be saved in the same folder as the individual data files. It is not sensible to store relative path information inside the file, as it would make it difficult to e-mail a Multi Chart file if the recipient would have to re-create the exact folder structure as the sender for the file to be displayed.

Any annotations added to the Multi Chart display are saved in a separate annotation file with the file extension "*.anno". This file must be located in the same folder as the Multi Chart file to be included in the Multi Chart display.
To open a previously saved Multi Chart configuration file, click on the toolbar icon or select **OPEN**... from the **File menu** (on page 131), then select the "*.multi" file to be opened.

To save a Multi Chart file under a different name, select the Save As... command from the **File menu** (on page 131) and enter a new file name.

**Note:** You can export a Multi Chart file as a PDF, but not in any of the other export file types.

LogTag indicator products such as the TICT or TIC20 do not have date/time related readings and therefore do not appear on the multichart.

**Selected LogTag® Data files (*.sltd)**

Users can save a file, which when opened again, will only display a selected time window of the recorded data. The time window of this "Selected LogTag® Data" file is defined through the zoom settings of the currently active tab, or can be entered in the dialog box displayed when the "Save as..." command from the **File menu** (on page 131) is chosen with 'Selected LogTag® Data (*.sltd)' as the file type.

Select a file name and location for your file.
The chart of this file, which contains pre-start readings, has been zoomed to show only a small proportion of the readings:

![Chart showing zoomed data](image)

The window slider shows there are still readings earlier and later than the displayed data.

When saved as a *.sltd file, it will be automatically re-opened and now only displays the previously zoomed readings. You will note that the pre-start readings are no longer displayed and you cannot zoom out or display any readings before and after the selected time frame.

![Chart with zoomed data](image)

Note: Those readings which are no longer displayed are still present in the file. Any *.sltd file can be saved as a *.ltd file, and when re-opened, all readings taken by the recorder during this trip will become available for viewing.

This can also be achieved by simply re-naming the file from *.sltd to *.ltd.

Files with a *.sltd extension cannot be read by versions of LogTag Analyzer earlier than 2.0, they can however be read once renamed to *.ltd.

*.sltd files can also be opened directly from e-mail attachments or by double clicking the file in Windows Explorer, as the installer for LogTag Analyzer registers this file extension and associates it with LogTag Analyzer.

For TRID30-7 and TRED30-7 the *.sltd files no longer contain the summary tab.
Saving a file for use in spreadsheets

Occasionally you may wish to export a LogTag data file so you can analyse it in more detail using a spreadsheet program such as Microsoft™ Excel. You can choose between a few different options to achieve this:

- You can use the **FILE - SAVE AS** command from the menu, and select the *.csv option. You can include pre-start data by ticking the box.

![Save As dialog](image)

CSV files can be read by most spreadsheet programs.

Please note that files created by LogTag Analyzer may not always be true CSV files (**Comma Separated Values**), as they use the list separator from the Windows operating system. It does however mean the file can be opened with MS Excel without going though the data import facility. To create a true CSV file select "Use custom list separator" and enter a comma in the adjacent field. You can also use the custom list separator to generate files for applications which require other list separator characters.

- Select the Data tab and press **CTRL-C** or choose **EDIT - COPY** from the menu. Open an empty worksheet in your spreadsheet program and select **CTRL-V** or choose **EDIT - PASTE** from the menu. The data will be pasted in the cells and you can save the file in the format of your spreadsheet program.

- Automatically export the data into a CSV file when a logger is downloaded. Please see **Exports and Reports** on page 123 for further details.

**PDF files**

LogTag Analyzer can save the currently active LogTag® data window to a PDF file. One single file will be generated which contains chart images, summaries and a data list.

PDF files can be generated automatically, or by selecting "Save as" from the **File menu** (on page 131). Select a file name and location for your PDF file. Automatic generation of PDF files is
enabled in the section about *Exports and Reports* on page 123. Here you can also define the composition of the PDF file.

Click the button; the following dialogue window is displayed, allowing you to select which content of the PDF file will be created.

Note: Only one single Data listing will be created. Depending on which sections are enabled, pre-start only, chart only or all readings will be included.

Note: The report page is always included in the PDF. For display loggers, the day summary will also be always included.
Each section can be identified by its heading. If a chart is zoomed, the PDF file will also contain a zoomed setting.

**Analysing the results**

Data are analysed in file windows, which appear inside the main LogTag Analyzer window. Each file window displays the data of a single logger and has a series of tabs along the bottom. Clicking on a tab changes the way the information is displayed; different windows can display different tabs.

You can activate Multi Chart display, and all open file windows are combined into a single window. You can find more information about this feature in Combining Charts into a single chart on page 80.

The different ways to display the information in the file windows are:
The most used tabs will typically be the report tab or the chart tab, as the information displayed in either of them gives an instant overview of the data, whether just recorded and downloaded from a LogTag or retrieved from previously stored data files.

Pre-start logging is a feature that allows a LogTag to record readings between the time it is configured and the time it is started via the push button method, meaning data are collected even if a user accidentally forgets to start the recording. You can find out more about this feature in pre-start logging on page 45.

In some cases not all tabs previously described will be displayed. You may for example see only Report, Chart, Data and Summary, if the LogTag has been configured not to record any pre-start data.

Note: Indicator products such as the TICT or TIC20 only display the Day summary tab.

The following sections describe each type of information display (Report, Chart, Data, Summary and Day Summary) in more detail.
Chart Display

Clicking on the CHART tab presents the information in the file window as a 2-D line chart with markers. When you first start LogTag Analyzer, this tab is activated by default, but you can change this in the OPTIONS.

Figure 23: Chart sample

1 - Chart title
2 - Above alert area
3 - No alert area
4 - Graph line
5 - Below alert area
6 - Time line
7 - Time zone
8 - Chart Statistics
9 - Tabs
10 - Chart legend
You can see how humidity and/or temperature changed over time. If you want to see parts of the graph in more detail, you can zoom in and display a smaller section of the data. Move the cursor to the upper left corner of the area you wish to magnify, hold down the left mouse button and move the cursor so it covers the area you wish to see:

When you release the left mouse button, the the area highlighted now fills the window:

Figure 24: File window with zoomed chart

1. - Chart sub-title
2. - Mouse cursor on data point
3. - Tooltip
4. - Marker
5. - Download mark
6. - Inspection mark

Depending on the zoom level not every data point may have a marker displayed. LogTag Analyzer intelligently adjusts the display of markers so the graph line is still visible. These markers can also be turned off, and their appearance can be altered. You can learn more about this is the Charts Section (see "Charts" on page 106). You can also see a number of other
marks. Inspection marks are recorded in the LogTag's memory each time its START MARK button is pressed. Each inspection mark is numbered and can be identified by counting the number of marks on the Chart display. Download marks are recorded in the LogTag's memory each time it is downloaded to a PC.

When the mouse pointer is moved over the chart, a tooltip is displayed near the mouse pointer (as shown in the example). It displays the reading closest to the mouse pointer position. If the readings are very close together, you may want to zoom in further and then inspect individual readings with the help of tooltips.

The tooltip will always show date and time of the recording, even when elapsed time is chosen for the x-axis display. This will allow you to get the date and time information quickly without having to change the setting in the options for Charts (on page 106).

You can add annotations (Chart annotations on page 69) and a subtitle (Chart subtitle on page 71) to the chart.

The chart area displayed in the window can now be copied to the clipboard by either selecting a picture of the highlighted area can be placed on the clipboard. This picture can be then be pasted into any Microsoft Windows® application. For example, if you are writing a letter and want to illustrate a point based on chart data from a LogTag, you can paste the picture of the chart directly into the letter.

You can change the appearance of all charts permanently by changing the options in Charts (on page 106). If you wish to temporarily change the appearance of only a single chart in the file window you can use the context menu, which is accessed by right clicking while the mouse cursor is in the graph area.

The appearance controls influence general items on the chart, such as turning on and off marks and grid lines; these can be useful for finding information on the chart easier. Clicking on an enabled item will disable it and vice versa.

The shade controls can be used to highlight the alert and non alert areas of the chart for easier identification.

You can use the zoom controls to define which part of the data is displayed on screen (see Zoom Control on page 67) and the Annotation menu to display text on the chart (see Chart annotations on page 69).
Zoom Control

Manual Scaling
You can zoom into any detail of the chart (until you only see a single reading) by using your mouse as described. You can, however, also use direct data input to have a more refined control over the data to be displayed, such as temperature and humidity scale or the range of readings by time and date.

Call up the context menu by right clicking anywhere on the chart area and select **Manual Scaling**. The following dialog will be displayed:

![Manual Scaling dialog](image)

**Figure 26: Manually scaling a chart**

You can select:

- Range of sensor; the chart is zoomed to the minimum and maximum values for each sensor. These values are dependent on the recorder model.
- Range of readings; the chart is zoomed to the minimum and maximum reading values.
- Manual Scaling; this option lets you specify the date/time range, temperature and humidity ranges (if applicable) for the chart display. Initially the dialog shows the current zoom settings.

Click **OK** to apply your selected settings.

To return to the previous zoom level, use the Zoom Out (🔍) command in the **Edit menu** (on page 133), on the **toolbar** (see "Toolbar commands" on page 137) or by right clicking anywhere on the graph area and selecting **ZOOM OUT** in the context menu.

By default, each chart is initially displayed zoomed to the range of readings. This default setting can be changed in the Options dialog (see chapter "Charts" (on page 106)).

**Inspection and download mark zoom**
You can also zoom directly to certain parts of the chart by using the inspection mark zoom icons on the toolbar and in the context menu.

**🔍 Zoom out**
Zooms out one level of the chart in the currently active window. If you are displaying a chart and this function is not available, then all available data are already being displayed and you cannot zoom out any further.

**🔍 Zoom to inspection marks**
This zooms the chart so readings are shown between the oldest reading recorded and the first inspection mark that exists in the data. If this function is not available then there are no inspection marks in the data currently being displayed.

The next two commands will not be available until this command is activated.
**Previous inspection mark group**

This zooms the chart so readings are shown which were recorded between the first inspection mark currently being displayed and the previous inspection mark.

This function is disabled when either the oldest reading is already being displayed, or the "Zoom to inspection marks" function has not been activated.

**Next inspection mark group**

This zooms the chart so readings are shown which were recorded between the last inspection mark currently being displayed and the next inspection mark.

This function is disabled when either the newest reading is already being displayed, or the "Zoom to inspection marks" function has not been activated.

In addition to zooming out and manually scaling the chart the context menu gives you some additional functions not available through the toolbar.

**From first reading to first inspection/download mark**

This zooms the chart so readings are shown between the oldest reading recorded and the first inspection mark or download mark that exists in the data. This different from the "Zoom to inspection marks" feature as it also evaluates download marks. You can use this function to look at the first set of data where a logger is downloaded more than once during a trip, for example in a cold chain transport where goods are transferred from a cargo ship to a distribution truck and you are only interested in the shipping portion of the trip.

**From last inspection/download mark to last reading**

This zooms the chart so readings are shown between the last inspection mark or download mark and the newest reading in the data. This is different from the "Zoom to inspection marks" feature as it also evaluates download marks. You can use this function to look at the last set of data where a logger is downloaded more than once during a trip, for example on a distribution truck which has multiple drop off points and you are only interested in the last portion of the trip.

If either of the two menu points are greyed out you are either already looking at this part of the data, or there are no inspection or download marks present.

In the General section of the Options you have the opportunity to define either of these two settings as the default when files are opened or recorders are downloaded. You can see in the section **General Settings** (on page 104) how this is applied.
Chart annotations

To include additional information in your chart you can add chart annotations. These will be displayed and printed with your chart. Click the right mouse button at the location where you want to add the annotation. The context menu will open, allowing you to select **Annotations**.

Select **Add**, enter the annotation text and click **ok**. The annotation will be displayed in the chart. When you zoom the chart display, the annotation will stay on screen as long as the point to which the annotation was attached is also displayed.

To edit an annotation, click the right mouse button while the cursor is at the annotation’s location and select **Edit** from the annotations menu. Edit the text and click **ok** to display the edited annotation.
To delete an annotation, click the right mouse button while the cursor is at the annotation's location and select "Delete" from the annotations menu. The annotation will be deleted. To delete all annotations, select DELETE ALL.

Selecting the "Show" command from the Annotations popup context menu will show or hide all of the annotations on the chart.

To save the annotations, click the toolbar button or select the SAVE command from the File (see "File Menu" on page 131) menu. The annotations will be saved in a file with the same name as the data file and the file extension ".anno".

When saving annotations in Multi Chart mode, the software will ask you to specify a file name for the Multi Chart configuration, if you are saving this configuration for the first time.

**Note:** The contents of the original file are not changed. If the ".anno" file is accidentally deleted, the annotations will no longer be displayed, but the recorded data will still be intact.
Chart subtitle

The chart subtitle is displayed and printed underneath the chart title.

To edit the subtitle, right-click on the area above the chart and select "Edit Chart Subtitle" from the popup context menu.
Enter or modify the text, then click **OK** to display the edited subtitle. To remove the subtitle, delete the text in the Edit Chart Subtitle dialog and click **OK**.

To save the chart subtitle click on the toolbar icon or select the **Save** (see "File Menu" on page 131) command from the **File** (see "File Menu" on page 131) menu.

If the LogTag Analyzer application is in Single Chart mode, the subtitle (and annotations) for the currently active chart will be saved in a file with the chart file name and the file extension `.anno`.

In Multi Chart mode, the subtitle is saved in the Multi Chart configuration file (file extension `.multi`). If you are saving the configuration for the first time, you will be asked to specify a file name for the Multi Chart configuration.
Report Display

The Report display provides a convenient and quick way of seeing all important information for a trip in one single screen.

Figure 27: Sample report tab

1. Download and time zone information
2. General information
3. Alarm pass/fail
4. Configuration information
5. Trip information
6. High Alarm information
7. Low Alarm information
8. Receiver notes
9. Graph area
10. Event information
The graph area shows a slightly smaller version of the chart. The zoom controls are linked to the chart tab. If you zoom in to a particular area on the report's chart area, the same area will be displayed in the chart tab and vice versa. You can use the same zoom controls as in the chart, with some exceptions to the context menu controls.

**Figure 28: Report tab context menu**

1. Grid control
2. Zoom control
3. Receiver notes
4. Annotations

Some of the appearance and shade controls are no longer available, however the remaining grid and zoom controls work the same as they do in the chart tab on page 67, and so does the annotation function on page 69. Annotations added in the chart tab will be displayed in the report chart and vice versa.

When you select **RECEIVER NOTES** you will be able to add a text field that is then displayed in the report's Receiver Notes section every time the file is opened.

These notes are stored in the "*.anno" file, which also holds the chart annotations. This file must be present in the same directory as the "*.ltd" file.
If you enlarge the width of the window sufficiently, the report will be displayed in landscape format.

![Report tab in landscape format](image)

**Figure 29: Report tab in landscape format**

**Data Display**

When you click on the data tab the readings are displayed in a list in chronological order from top to bottom, also showing index, date & time and elapsed time. On the list you can also identify any special marks attached to the reading, such as download marks (identified through purple background) and inspection marks (identified through red background). The colour of the text identifies if a reading has been above the upper alert value (red), below the lower alert value (blue) or within specification (black). You can scroll through the readings with the arrow, page up/down, home and end keys, or use the mouse to move the readings with the scroll bar.

![Sample data grid](image)

**Figure 30: Sample data grid**

1 - List header row
The data tab will only display those readings shown on the corresponding chart. If the chart is zoomed in, the data tab gives access to only the zoomed readings. You cannot use the scroll bar or arrow keys to display readings before or after the currently zoomed readings.

The list grid can be copied to the Windows clipboard and pasted into other windows applications such as spreadsheets, including the list header row. When the corresponding chart is zoomed in, only those values will be copied.

The zoom controls available for the chart tab are inactive in the data tab.

**Summary Display**

The summary tab offers a brief statistics overview of some of the important trip data. You can customise the statistical data you wish to include in this tab in the Options dialogue for the Summary Statistics on page 105.

The first section shows the data for the complete trip, regardless of whether or not the chart is zoomed in. The second section is only displayed if the chart is zoomed in, and displays the statistics for only the zoomed readings.
If there are readings beyond the limits of the sensor within the time interval displayed, the statistics for this interval will show "*".

The zoom controls available for the chart tab are inactive in the summary tab.

If inspection marks are present in the data, statistics summaries for each of the inspection mark groups in the data can be seen amended to the end.

The list grid can be copied to the Windows clipboard and pasted into other windows applications such as spreadsheets, including the list header row.

**Day Summary Display**

The day summary tab is displayed for LogTags with an integrated statistics memory.
LogTag recorder products with display

For these recorder models the day summary display shows the history of up to 30 days, arranged into 24 hour periods, with information about maximum and minimum values for the day, and if alarms have been triggered on those days.

Figure 31: Day summary display

- Day summary header row
- Summary grid
- Alarm marker
- Above Alarm level marker

The Day Summary grid can be copied to the Windows clipboard and pasted into other windows applications such as spreadsheets, including the header row.
LogTag Indicator products with display

These indicator products have multiple alarm levels. Time above or below each alarm level is displayed, with information about maximum and minimum values for the day, if alarms have been triggered on those days and how much time elapsed on that day until the alarm was triggered.

**Figure 32: Day summary display**

1. Day summary header row
2. Alarm duration and trigger time
3. Summary grid
4. Total time monitored

The Day Summary grid can be copied to the Windows clipboard and pasted into other windows applications such as spreadsheets, including the header row.
Combining charts onto a single chart

To overlay multiple charts in one view, select the Multi Chart command. All charts that are currently open will be displayed together. Additional files opened while in Multi Chart mode (including data downloaded from LogTags) will be added to the display.

Each of the individual charts will be displayed with a letter symbol to allow you to tell them apart. The legend contains an entry for each chart showing the chart name and the corresponding letter.

You can change the background color for the Multi Chart display through the Charts section in the Options Window.

To remove charts from the Multi Chart display, use the Single Chart command to switch to Single Chart mode, then close the files you don’t want to display. Select the Multi Chart command to switch back to Multi Chart mode.

You will notice that the Data and Summary tabs are not available in the Multi Chart display. If you require additional information about the chart data, activate the display of the desired statistics on in the Chart Statistics section in the Options Window. The chosen values will be displayed separately for each chart.
You can also view Min, Max and Average Charts (see "Special Chart Tabs" on page 84), and select other options.

**Changing Chart Colours**

By default, all charts in the Multi Chart display are displayed in the colors specified in the Charts (on page 106) section within the Options (see "Customising the software" on page 102) Window.

To change the display color of individual charts/sensors, move the mouse pointer over a chart until the tooltip is displayed. Right-click, then select "Change Chart Color" from the popup context menu.

Select the desired colors for the chart readings and markers in the color selector boxes. To restore the default color (as specified in the Charts (on page 106) section within the Options (see "Customising the software" on page 102) Window), select the "Restore Defaults" command.

**Shifting chart start times**

For easier data comparison, chart start times can be shifted in Multi Chart display. There are two ways to shift a chart along the time axis:

1. Move the mouse pointer over the chart until the appropriate tooltip is displayed. Right-click, then select the "Shift Chart" command from the popup context menu. This will cause the following dialog to be displayed, where the new start time and date can be entered, or the chart can be revert to its original date/time by selecting the "Original start time" button. Click the OK button to display the change.
2. Press and hold the CTRL key, left-click on the chart you would like to move, and drag the chart to a new position.

An additional time axis is displayed for each shifted chart indicating the corresponding time in relation to the original start time.

Note: Shifting a chart will not change any of the original recorded data, only the location the data is displayed in relation to other charts within the Multi Chart display will change.

### Aligning Charts

Select "Align Charts" from the popup context menu to automatically align all charts in the current Multi Chart window.

The charts are aligned to the earliest start time:

- "Chart" tab: All start times are aligned.

- "Pre-start Chart" tab: All charts with Pre-start readings are aligned to the earliest Pre-start reading.

- "All Chart" tab: Charts are aligned to the earliest reading (Pre-start reading if any Pre-start readings have been recorded for the chart).

Every chart is assigned a different colour and a time axis is displayed to illustrate the original start time. You can display the elapsed time instead of the date/time by selecting the "Elapsed Time" option in the Chart Options dialog (Charts on page 106).
Aligning charts in one tab will also influence how these charts are represented in the other tabs. If for example you select "Align Charts" in the "Chart" tab, and switch to the "All Chart" tab, you will notice that the charts are now aligned at a new origin, with all pre-start readings to the left and all readings to the right of this origin. The charts in the "Pre-start" tab are aligned with the last pre-start reading to the right.

To revert to the original start times for all charts, select in the toolbar to switch to Single Chart mode, then switch back to Multi Chart mode with.
Special Chart Tabs

When you select the average tab command in the toolbar, up to three additional chart tabs will be shown, with the Chart Average tab highlighted:

These chart tabs display graphs calculated from the "Chart", "Pre-Start Chart", and "All chart" tabs and show minimum, maximum and average value graphs. Changes in either of the three original data displays, such as adding a new file and aligning or shifting charts, result in a re-display of the corresponding "Min/Max/Average" tab, e.g. if one of the charts in the "Pre-Start Chart" is shifted, the "Pre-Start Min/Max/Average" chart would redraw showing graphs based on the updated values.

You can annotate these special chart tabs in the same way as other chart tabs; such annotations will be visible in the other chart tabs and are stored with the multi chart when saved.

Please note that following behaviour applies to these special chart tabs:

- Zoom settings will not be transferred to the "Average" tabs.
- Download marks and inspection marks will not be displayed in the "Average" tabs.
- Non-validated readings and re-calibrated readings will not be displayed with the special attributes, even if set in the options. If you have chosen to "show non-validated readings", they are included in the minimum/maximum/average calculations, otherwise not.
- To avoid memory overflows there are some restrictions regarding the maximum allowed time span of the charts in a multi-chart. These restrictions vary with logging interval, should you try to add a chart outside the allowed range following dialogue box will appear:

In this case the multi chart will disassemble, so you can close the window whose chart you no longer want to display, and re-assemble the multi-chart by clicking on.
- If one or more of the charts have sections with readings outside the LogTag's sensor range, LogTag Analyzer is unable to calculate the minimum, maximum and average values, and those sections of the graph will not be displayed. This will likely result in a “broken” graph line, regardless of whether "show readings beyond specifications" in the Charts (on page 106) section in the Options (see "Customising the software" on page 102) Window is enabled or not.

- Due to the large number of calculations performed in this feature, specifically when opening large numbers of charts spanning long periods, having the average tabs displayed can occupy large amounts of memory and run slow. Therefore we recommend only turning the feature on when required.

Clicking on the highlighted average tab command will turn the average tabs off. Selecting the single charts command in the toolbar while the average charts are active will disassemble the multi chart, and when switching back to multi chart the average tabs will be displayed again until turned off.

**Behind The Scenes**

To create some meaningful results, LogTag Analyzer uses a special trend line process to calculate the minimum, maximum and average values across multiple charts, rather than a histogram. It is important you understand this mechanism, so you can interpret the displayed readings correctly.

This is an example of two LogTag®s, one with a 5 minute log interval (A) and the other (B) logging every 2 minutes.
Before the data are displayed in an average tab, LogTag Analyzer normalizes every chart’s readings so they fall in line with the logging interval of the LogTag with the shortest log interval, in this case unit (B). It does not shift any charts, but rather calculates a theoretical value for those reading times by linear interpolation. Interpolation determines probable environmental conditions, i.e. what the LogTag would have recorded if taking a reading at that time.

Without this method, it would not be possible to compare LogTags with different log intervals, or units that have the same log interval, but were started at different times.

Starting with the earliest time present in the chart, a value is created for each LogTag as if it had recorded a log at that time. It is those values that are used to calculate and display the minimum, maximum and average charts.

As a result of this process, absolute values for minimum and maximum may not always be shown if they do not fall on normalized times, as seen in the example at 10:35 - despite 21°C being the maximum it will not be displayed as it is not a normalized value.

Note: The charts in above example are based on LogTags started at the same time. If unit (A) had been started earlier, depending on the start time unit (B) may also have its readings interpolated. To ensure the chart with the shortest log interval always has its real values shown, please use the Aligning Charts (on page 82) function from the context menu.
Automatically calculated statistics

When a file is displayed either from downloading or from calling up a stored data file, the software will automatically calculate and display some statistics of the recorded data. These statistics are shown on the corresponding Summary tab and are also calculated for each sequence of data points between the inspection marks.

If any readings within the time interval are beyond the limits of the sensor, the values for Average Reading, Standard Deviation, and Mean Kinetic Temperature will not displayed for the relevant time interval.

Average Reading

The Average Reading is the arithmetic mean of the sequence of data points. It is calculated by adding all the data point values together and then dividing the total by the number of data points. Mathematically this formula can expressed as illustrated in the following picture:

\[
\text{av} = \frac{\sum_{i=1}^{n} t_i}{n}
\]

Where:

- \( \text{av} \) the calculated arithmetic mean
- \( n \) the number of data points to include in the calculation
- \( t_i \) a data point to include in the calculation

For example, if there were 5 data points to calculate the arithmetic mean of and they were, 12.3, 15.9, 16.2, 14.7, 14.9, then the arithmetic mean would be 14.8.

The number of decimal places displayed can be set to 1, 2 or 3 by clicking Options from the Edit Menu, then navigating to the the Summary or Chart Statistic section, highlighting Average Reading and clicking on the button.

Confirming this dialogue with OK will set the number of decimal places to the number selected in the drop down box.
Standard Deviation

The standard deviation is a useful measure for determining how spread out the readings are from the arithmetic mean (Average Reading). Most controlled environments typically try to keep the environmental conditions at a stable and consistent humidity and/or temperature. The standard deviation can be used to help indicate how stable the environmental conditions were maintained. One standard deviation (sometimes expressed as "one sigma") away from the mean, positive or negative represents approximately 68 percent of all the readings. Two standard deviations, or two sigmas, away from the mean represents approximately 95 percent of the readings. Three standard deviations represent about 99 percent of the readings.

For example, if the arithmetic mean of the readings was 50.6°C and the standard deviation was 2.3°C, then approximately 68% of the readings were between 48.3°C and 52.9°C, 95% of all the readings were between 46.0°C and 55.2°C and 99% of the readings were between 43.7°C and 57.5°C. Furthermore, if all the readings were recorded over a span of 1 day (24 hours) then the temperature was between 48.3°C and 52.9°C for approximately 16 hours and 19 minutes during the recorded period of time.

LogTag Analyzer allows the calculation of sample or population based standard deviation.

\[
S = \sqrt{\frac{\sum_{i=1}^{n} (t_i - \text{av})^2}{n-1}} \quad S_N = \sqrt{\frac{\sum_{i=1}^{n} (t_i - \text{av})^2}{n}}
\]

Figure 33: Sample based standard deviation

Figure 34: Population based standard deviation

Where:

- \( s \) the calculated sample based standard deviation
- \( s_N \) the calculated population based standard deviation
- \( n \) the number of readings to include in the calculation
- \( \text{av} \) the calculated arithmetic mean
- \( t_i \) a reading to include in the calculation
The number of decimal places displayed can be set to 1, 2 or 3 by clicking **Options** from the **Edit** Menu, then navigating to the the Summary or Chart Statistic section, highlighting Standard Deviation and clicking on the **Customise...** button.

Here you can also set whether the standard deviation should be sample based or population based.

Confirming this dialogue with OK will set the number of decimal places to the number selected in the drop down box and the calculation method.

For a more detailed explanation of the various ways to calculate standard deviation please consult the relevant literature related to statistical and probability calculations.
Mean Kinetic Temperature

Some products and materials have accelerated rates of degradation at higher temperatures. For example, perishable food items, pharmaceutical products and many forms of bacteria can grow/degrade exponentially as the environmental temperature increases. Mean kinetic temperature is a calculation that accommodates the non-linear thermal effect temperature can have on products. Mean kinetic temperature is represented as the equivalent temperature the product was thermally subjected to during the period of time the various temperature reading were recorded.

Mathematically the formula for calculating the mean kinetic temperature can expressed as illustrated in the following picture:

\[ \text{mkt} = \frac{-\Delta H}{R} \ln \left( \sum_{i=1}^{n} \exp \left( \frac{-\Delta H}{R} t_i \right) \right) - 273.15 \]

- \( \text{mkt} \) is the mean kinetic temperature, in degrees Celsius
- \( \Delta H \) is the activation energy
- \( R \) is the universal gas constant, which is 0.0083144 KJ/mol K
- \( n \) is the number of data points to include in the calculation
- \( t_i \) is a data point to include in the calculation, in degrees Celsius

For example, if there were 5 data points to calculate the mean kinetic temperature of and they were, 12.3, 15.9, 16.2, 14.7 and 14.9 degrees Celsius, then the mean kinetic temperature would be 14.9 degrees Celsius using the default \( \Delta H \).

By default LogTag Analyzer uses an activation energy value of 83.144 KJ/mol for the calculation.

You can select a custom value for \( \Delta H \) by clicking Options from the Edit Menu, then navigating to the the Summary or Chart Statistic section, highlighting Mean Kinetic Temperature and clicking on the Customize button.

Confirming this dialogue with OK will use the default value or the entered custom value as selected.

Charts and the Statistics pages will display the custom \( \Delta H \) parameter if it is different to the default value:
**Degree Minutes**

There are some products and materials that exist which can change their characteristics and/or degrade if they experience temperatures which are not within ideal conditions for long enough. For example, some products may experience freezer burn if they experience an extremely cold condition or experience a colder than ideal temperature for long enough period of time. Other products for example, ice cream, change their characteristics if they experience temperatures which allow it to melt. The LogTag Analyzer will automatically display the results of two separate Degree Minutes calculations. The result of the first Degree Minutes calculation displayed will be based on the readings that were recorded below the ideal conditions and the result of the second Degree Minutes calculation displayed will be based on the readings that were recorded above the ideal conditions. The ideal conditions used in the calculation of the Degree Minutes formula are based on the upper and lower alert values that were configured when the LogTag was originally prepared for use.

Mathematically the formula for calculating the degree minutes above alert can be expressed as illustrated in the following picture:

\[
\text{deg min} = \sum_{i=1}^{n} \text{abs}(t_i - a) \times s
\]

Where:

- \(\text{deg min}\) Total Degree Minutes spent above/below the alert threshold.
- \(t_i\) The temperature that was above/below the alert threshold.
- \(a\) The alert temperature threshold.
- \(s\) The duration of time, in minutes, the temperature was sustained.

For example, if there were 5 data points to calculate the degree minutes of and they were, 12.3, 15.9, 16.2, 14.7 and 14.9 degrees, each of these temperatures were recorded at 2 minute intervals and the high alert temperature threshold was 12.6 degrees, then the degree minutes temperature above the upper alert threshold would be 22.6 degree-minutes.
Displaying statistics

The statistics displayed on the Summary tab can be configured in the Options dialog. Refer to the chapter "Summary Statistics on page 105". By default, all statistics are displayed on the Summary tab.

Statistics can also be displayed on the chart, underneath the legend. See chapter "Chart Statistics (on page 105)" for more information about configuring the chart statistics.

If there are readings beyond the limits of the sensor within the time interval being displayed, the statistics for the relevant interval will be displayed as "***".
Printing the results

Printing from LogTag Analyzer is slightly different to printing from other common Windows software, as the printer functions in terms of range of information to print rather than range of pages. This technique allows you to focus on what you want printed rather than the pages showing the information.

You can choose to print all of the information, select a range of dates and times to print from or select a range of "inspection" marks. This could be very important for transit monitoring since post trip and pre-event data are not significant to a discussion or dispute centering on a humidity and/or temperature maintenance issue.

The print window can be brought up by simply clicking once on the "Print" icon (_previous) located on the toolbar (see "Menus and Toolbars" on page 130) or by clicking the "Print..." menu item from within the File menu.
Sending a file by e-mail direct from Analyzer

You can send files of interest to another person, by e-mail, directly from the software without the need to exit to your e-mail software or to deal with file attachments.

While you have the file of interest open and being displayed on the screen, just click once on the "Send Mail" icon ( ) located on the toolbar (see "Menus and Toolbars" on page 130) and your e-mail software will pop up with the file already inserted as an attachment. Type the desired e-mail address to send the file of interest to, add any message that you wish to include, and then click "Send". That is all.

Clicking the "Send..." menu item within the File menu will achieve the same results as clicking the "Send Mail" icon as previously described.

Note, the recipient of the file will also need to have a copy of the LogTag Analyzer software to open and view the file that you sent. LogTag Analyzer software is free and can be downloaded from the LogTag Recorders Internet site, http://www.logtagrecorders.com.

If you want to attach your data files in file formats other than the LogTag Analyzer format, specify the desired file formats in the Exports and Reports (on page 123) section in the Options (see "Customising the software" on page 102) Window. The data files will automatically be attached to your e-mail(s) in the desired formats.

To send a Multi Chart configuration, the configuration must first be saved to disk (see chapter Saving a Multi Chart configuration). The "Send Mail" command will automatically attach the multi chart configuration file, the annotation file (if annotations have been added) and the relevant individual data files to your e-mail(s).

Note: You can automatically send e-mails and upload files to ftp sites using LogTag Analyzer's automated SMTP and FTP functionality. Please see Automatic Uploading to FTP sites and automatic e-mailing on page 108 for further details.
Calling up previous results

The files that have most recently opened and displayed are listed towards the bottom of the "File" menu. To open other files, click the "Open" icon located on the toolbar, which will display the "Open" file dialog similar to the following picture and allows the user to locate and open one or more files of interest.

You can open files from all locations accessible by the Windows Operating System, including network and ftp locations. Please refer to your operating system's help for more information.

Clicking the "Open..." menu item within the File menu will achieve the same results as clicking the "Open" icon as previously described.

After the software has been installed for the first time, there are two recently opened files listed in the "File" menu, even though no files have been opened yet. These are sample files, which were installed along with the software so that users can see an example of information that can be retrieved from LogTags. These files are not required for the correct operation of the software and therefore may be deleted at any time.

You can also open files directly from within Windows Explorer or from within your e-mail software by double clicking on the file or right clicking and selecting "open" from the context menu. When opening files from e-mail programs that store attachments in temporary folders such as MS Outlook, you may be asked to store the file in a new location when performing further actions such as selecting multi-charts or uploading to FTP sites.
If the software is unable to open the file, it will display an error similar to the following picture. Clicking on **Check Now** will start the process of checking the Internet for an updated copy of the software.

---

**Digital signatures**

Support for digital signatures is primarily provided for compliance with the US FDA 21 CFR Part 11 regulation - Electronic records and electronic signatures. Various industries however, may find inclusion of digital signatures beneficial towards their quality control and assurance systems.

Digital signatures allow users to include their digital signature within a LogTag Analyzer file along with a meaning/reason for the inclusion of the digital signature. To add digital signatures to LogTag Analyzer files, the copy of the LogTag Analyzer software being used must be connected to the LogTag User Server software. For more information about how to get the software to connect to the LogTag User Server software see the "User Server (on page 127)" set of options settings and/or contact your local network administrator.
While the file that the digital signature is to be added to is open and currently selected, add a digital signature by clicking on the "Digital Signatures" icon located on the toolbar (see "Menus and Toolbars" on page 130), which will display the "File Properties" dialog with the "Digital Signatures" tab already activated, similar to the following picture.

![File Properties dialog](image)

Then click to begin the process of adding a digital signature to the file. If is disabled, moving the mouse pointer over and leaving it still for a short time will reveal the reason why the button is disabled.
Once the "Add Digital Signature" dialog is visible, enter your LogTag Analyzer user password and select the meaning for the digital signature that is being added.

![Digital Signature Dialog]

Click [OK] to permanently add the digital signature to the file or [Cancel] to not add the digital signature. Multiple digital signatures from the same and/or different users to LogTag Analyzer files may be added to a single file.

---

**How secure is my data**

All LogTag files are encrypted and contain checks to detect if the file has been tampered with since it was originally created. If the software detects that a file has been tampered with, even by only one character or has become corrupted and therefore the data within does not represent the data originally retrieved from the LogTag, the software will not open the file and display the information within.

An additional validation and security feature of the LogTag is that it will automatically insert error detection codes periodically during recordings, which are used to detect corruption or manipulation of data. Whenever these detection codes for a block of recordings fails its integrity validation test, the relevant readings become marked as non validated readings. Non validated readings are displayed differently to validated readings to indicate that they have failed their integrity test.

Non validated recordings typically occur in the scenarios following scenarios:

1. One or more readings within the non validated block of readings is not the genuine recorded value.

2. The LogTag has been configured to perform continuous recordings and once the memory within the LogTag has been fully used, will cause older recordings to be overwritten, which will thereby invalidate the error detection code and integrity check for the block of readings the older recordings been overwritten exist within. In this scenario, it is not a problem that these recordings are non validated, rather it means that the particular block of recordings has only the validation and integrity protection offered by the communications between the LogTag and the computer system, which is typically the same, if not better than the level of
protection offered by every other brand of logger available in the global market, that LogTag Recorders know of.

3 A communications or hardware failure has occurred during the transfer of the data from the LogTag to the computer. In this scenario the problem is typically resolved by trying to retrieve the recordings from the LogTag again, while ensuring the contacts on the back of the LogTag are clean, that the contacts within the Interface Cradle are clean and that the contacts within the Interface Cradle are returning evenly to their normal position when the LogTag is removed.

Since the software does not modify any of the recorded data within a LogTag file at any time, if the software can open the file, regardless of how long ago it was created, the contents of the file will still represent the original recorded information retrieved from the LogTag.

Therefore, the files created by the LogTag Analyzer software meet all criteria for data integrity and data security as set forth in the US FDA 21 CFR Part 11 regulations. The firmware code that is embedded in the processor chip of each LogTag cannot be extracted or reverse-assembled. Accordingly, data sets that are recorded on the memory within the LogTag cannot be downloaded or modified except by being transferred to a LogTag file. There is no way to interfere with the process of the transfer of information between the LogTag and the software in such a way that data integrity would be compromised.

**Viewing file properties**

The file properties, which is accessed through the File Menu (on page 131) and/or through the toolbar command, provides users with a brief summary about the data included within the file, as indicated in the following picture.

<image_file_properties>
This file properties information is also available for viewing directly through the Windows Explorer software that was included with the Windows operating system, without the need to have the LogTag Analyzer software open. To view the information, simply locate the file of interest with Windows Explorer and, using the mouse, click the right button over the file and select the "Properties" menu item, with the left mouse button, from the menu that will be displayed, similar to the following picture.

Select the "Summary" tab and you will see the summary of the data contained in the file. If the contents of the file require a newer version of software to open and view, have become corrupted or have been modified then the "Summary" tab will not be visible.

If the LogTag has a limited number of trips left, this is also indicated here.
Many of the features offered by the software can be customized to suit your specific requirements.

The customization is performed in the Options dialogue windows, which can be opened by clicking on the icon in the toolbar or by selecting OPTIONS from the EDIT menu.

This will open the options window.

In This Chapter

General Settings ................................................................. 104
Summary Statistics .............................................................. 105
Chart Statistics ................................................................. 105
Charts ........................................................................... 106
Automation ..................................................................... 107
File and Folder Settings .................................................... 119
Exports and Reports .......................................................... 123
Dates and Times ............................................................... 125
Communication Ports ....................................................... 127
User Server ..................................................................... 127
Software Updates ............................................................. 128
Configuration Reports ...................................................... 129
Customising the software

To change any of the options, select the corresponding category in the left pane of the options window. You will see what can be changed in the right pane. Most of the options available will be applied as soon as you click on **OK**. For example, if the language selection and/or the date format are changed, all windows that are open will be updated without the need to restart the software. Please note, however, that these settings will only be permanently stored once you exit the LogTag Analyzer software.

All options, excluding the User Server settings, are stored on a per user basis. Therefore, if more than one user operates on a single workstation the software will allow different customization settings for each.

Some of the display settings, such as decimal point and date/time formats, are not controlled by the LogTag Analyzer's user settings dialogues, but rather by the regional settings of the Windows™ Operating System. These can usually be found in the Control Panel under "Regional and Language Options". Please refer to your Operating System's documentation for further assistance.
General Settings

The General Settings options allow you to change various preferences that will affect the overall appearance of the information shown by the software.

Show temperatures in

This will determine what units of measurement temperatures will be displayed in. The options include:

- Fahrenheit (°F)
- Celsius (°C)
- Kelvin (K)

Use Font

Determines what font to use to display and print information about LogTag recordings and is changed through the button. A sample of the font selected will be shown to you on the screen.

Default display time interval

This drop down box allows you to set the default time zoom level. You can set this to:

- All readings
- From first reading to first inspection/download mark
- From last inspection/download mark to last reading

The setting you select here will apply to all currently open windows as well as to newly opened windows, where a file is opened or a recorder is downloaded.

The section about Inspection and download mark zoom on page 67 explains how this feature works.
**Language**

This instructs the software which language for the software to use for all the information it displays and prints.

---

**Summary Statistics**

This option allows you to specify which statistics are displayed in the Summary tab. The statistics can be enabled or disabled by clicking the tick box for the relevant item in the list.

---

**Chart Statistics**

This option allows you to specify which statistics are displayed on the charts. The statistics can be enabled or disabled by clicking the tick box for the relevant item in the list.
Charts

The Charts options allow the various aspects of the charts that display the readings recorded by LogTags to be customized. At the base of the Window is a color selector and other relevant controls, which apply to the highlighted item on the list in the window.

Some experimentation with these settings will show very quickly how they work. Select a color in the color panel, click OK, and then go to the Data screen to see the results of the change.

Note that the three regions on the chart display can be controlled. LogTags can be configured to detect over and under conditions based on a series of temperature and/or humidity measurements. When the data is displayed graphically on the chart, these become color background regions. These are different colors for "at or above high alert limit", "between high alert limit and low alert limit" and "at or below low alert limit". This allows out-of-range and in-range data to be spotted easily on the listed or charted data.

By selecting a line style for the "above high alert limit" and "below low alert limit" regions you can improve the readability of the charts on black and white printouts.

You can choose to include or exclude non-validated data from the chart display by checking or un-checking the "Non-validated readings" check box in the list. If non-validated data is to be displayed, it can either appear just like validated data, or you can define a different colour and marker style to be used. Check the check box "Display non-validated readings differently:" to display non-validated data in the selected colour/style.

Please refer to section How secure is my data (on page 99) for a detailed explanation of non-validated data.

When readings beyond the specified measurement range of a LogTag have been recorded, the display will indicate this using the following techniques:

- The Chart display will not plot the out of range values and the chart curve will appear with broken lines.
- The Data display will include "<" or ">" for each reading that is beyond the specification range.
- The Statistics display will include "**" for each statistic that includes readings that are beyond the specification range.

If the option "Show readings beyond specification" is enabled, all reading values will be displayed, even if the recorded readings are beyond the operating range of the LogTag.
For example, the TRIX-8 has a published minimum temperature of -40°C. Temperatures to -41.5°C may be displayed if the "Show readings beyond specification" is enabled, however the accuracy of recordings between -40 and -41.5 is unknown. Temperatures between -40 and -41.5 will be displayed even if the temperature falls to a much lower actual value.

LogTag Recorders provides no guarantee of temperature reading reliability or accuracy beyond the published range for a given product and the "Show readings beyond specification" option is not recommended to be enabled for general use.

The "Elapsed Time" option switches the x-Axis display between date/time and elapsed time since the beginning of the display period.

"Show Min/Max/Average Tab" shows up to three additional tabs in a multi chart with graphs representing Minimum, Maximum and Average readings (See Combining Charts into a single chart on page 80.)

Most of the Chart Options settings can be enabled or disabled by clicking the tick box for the relevant item in the list.

Automation

The Automation options determine what the software does automatically when it detects a LogTag in the Interface Cradle.

Enable automatic download of readings from LogTags

Instructs the software to automatically retrieve recordings from a LogTag when it is placed in an Interface Cradle that is connected to the computer. While the software is automatically retrieving recordings from a LogTag an animated picture will appear on the screen to let the user know this action is being performed. With this function enabled, it is not necessary to go through the download wizard procedure. This function is very useful when working with multiple LogTags.

This function can be temporarily disabled by holding down the "Ctrl" key on the keyboard while a LogTag is placed in the Interface Cradle.
Reconfigure with same settings after automatic download

When this tick box is checked, a LogTag will be automatically configured with the same settings as for the previous trip, once the data have been downloaded. This option is greyed out if the Enable automatic download of readings from LogTags on page 107 option is disabled.

Display readings after successful download

Instructs the software to display the recordings after downloading them from the LogTag. The default display format is determined by the "Display" setting in the "File Settings (see "File and Folder Settings" on page 119)" option. This option will affect readings downloaded through the automatic download feature and when downloading through the Wizard approach.

Only show the latest set of readings after download

Instructs the software to only display the most recently retrieved set of readings on the screen. If there are multiple windows of readings open and being displayed, all of these windows will therefore be automatically closed and only the most recently retrieved set of readings will be displayed.

Automatic e-mailing and uploading to FTP sites

In the same way that LogTag Analyzer files are saved to a local hard drive, they can be automatically uploaded to an FTP site and automatically be e-mailed every time data from a LogTag are downloaded.

FTP (File Transfer Protocol) is a standard which describes how files are transferred between different computers and networks. SMTP (Simple Mail Transfer Protocol) is used for e-mail and describes how electronic mail is distributed across networks. Detailed explanations of how both FTP and SMTP work are beyond the scope of this manual, however if you wish to learn more about FTP, SMTP, e-mail and networking please refer to one of the many good articles available on the Internet, such as the ones on Wikipedia or the various FTP and SMTP client providers.

In the Automation dialogue you can select for both FTP and e-mail whether you wish to make the process automatic, on request, or both. If you activate manual uploading/e-mailing, but not automatic uploading/e-mailing, you need to press a button on the toolbar to upload or send the file in the currently active window. This button is in the form of a globe symbol, which also indicates which setting is currently active.
If the globe is active, and a small "F" is depicted in the lower right corner, automatic FTP uploading is activated.

If the globe is active, and a small "e" is depicted in the upper right corner, automatic e-mailing is activated.

If the globe is active, and both the "F" and the "e" are depicted, both automatic FTP uploading and e-mailing are activated.

If the globe is active, but no letter is displayed, neither automatic FTP uploading nor automatic e-mailing are activated. Manual FTP or e-mail functions may still both be active.

If the globe is grayed out, neither automatic nor manual FTP or e-mail functions are available.

When neither box for e-mailing has a tick, no e-mailing will be possible. Similarly, when neither box for FTP upload has a tick, no uploading via FTP will be possible, however in both cases the settings data will still remain stored.

Clicking on the FTP or E-mail settings buttons brings up the dialogue windows for the Basic FTP settings (on page 115) or the Basic SMTP and e-mail settings (on page 110). Usually this information will be provided by your network administrator. If your company has specific IT policies you may not be allowed to configure the settings yourself. In this case, or if your network administrator has already created a company wide access for multiple users, you may be provided with a settings file called "UploadSettingsU.dat". Your network administrator will detail instructions how to import these settings into LogTag Analyzer.

Changing FTP or e-mail settings while files are being uploaded will display following dialogue box when clicking OK to close the Options window.

Click "yes" to cancel the current upload, and "No" to continue uploading to the new location.

When uploading or e-mailing files a status window is displayed at the bottom of the LogTag Analyzer window.
This window shows status messages related to the FTP and e-mailing functions. The window can be hidden by right clicking anywhere in it and de-selecting the Upload/Send Status box. It can be re-displayed by right clicking anywhere on the menu or toolbar and selecting the Upload/Send Status box.

| ✓ Upload/Send Status | ✓ Toolbar |

Note: The manual e-mail function described here is different from the "send mail" button on the toolbar. The "send mail" button invokes your standard e-mail program, attaches the data file, requires you to fill in an e-mail address and press the send button. The manual e-mail function via SMTP does not use your standard e-mail program, but the configured SMTP settings and requires no further action once the globe button on the toolbar is pressed.

Note: Automatic upload via FTP and automatic e-mailing only work if a file is created by downloading data from a LogTag in the interface. If the uniqueness settings in the "File and Folder Settings" are set so that certain conditions do not result in creation of a new file, no file is uploaded or e-mailed either.

Files with formats other than the native LogTag Analyzer format will only be e-mailed or uploaded automatically if specifically selected in the FTP or SMTP basic settings. This may be different from the settings in the Exports and Reports (on page 123) option dialogue.

Note: If you upload a file via the manual or automatic FTP function, any file that already exists on the server with the same name will be overwritten. It is up to you to make sure files are created with unique file names.

**Basic SMTP and e-mail settings**

**Disclaimer**

The distribution of unsolicited e-mails provides huge inconvenience to anyone with an e-mail account. LogTag Analyzer's e-mail function allows the automated e-mailing of files to a large number of recipients simultaneously without user interaction. Some countries consider this as spam and will prosecute offenders.

It is therefore of the utmost importance that you as the sender obtain permission from the recipients to send these files. LogTag Recorders provides this functionality as a feature assisting in the distribution of information between various users within an organization and will not assume responsibility for any misuse of its software.

Setting up automated e-mailing requires two main pieces of information:

- The name of the SMTP server which you wish to use to send the e-mails and
- A valid user name and password for the SMTP server.
Once you click on the "SMTP Settings" button a dialogue window will appear, allowing you to enter the configuration data for the SMTP e-mail function. A lot of these settings will be familiar to you from your standard e-mail program.

![Image of SMTP settings dialog](image)

**Figure 38: Basic SMTP settings**

If you have been supplied with access data by your network administrator we suggest you print the following table, enter the data into the fields provided and keep it in a safe place.

<table>
<thead>
<tr>
<th>Field</th>
<th>What to enter</th>
<th>Your details</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMTP Server</td>
<td>Enter the name of the SMTP server you were given by your network administrator</td>
<td></td>
</tr>
<tr>
<td>SSL</td>
<td>SSL stands for Secure Sockets Layer. You may be required to tick this box if your SMTP server requires a secure connection. Typically this setting is not required, and your network administrator will set this up if required.</td>
<td></td>
</tr>
<tr>
<td>Use name and password</td>
<td>Some SMTP servers require an authentication method, especially if the SMTP server you are using is not provided by your ISP, e.g. if you are using e-mail accounts from a hosted site. In this case you need to tick this box and provide login data for this SMTP server. Quite often, though, you will not be required to use Authentication.</td>
<td></td>
</tr>
<tr>
<td>User Name</td>
<td>Enter the user name you have been allocated by your network administrator required for Authentication. Please note that for authentication this often needs to include a full e-mail address rather than just the SMTP login.</td>
<td></td>
</tr>
<tr>
<td>Password</td>
<td>Enter the password you have been given by your network administrator required for Authentication.</td>
<td></td>
</tr>
</tbody>
</table>
**LogTag Analyzer User Guide (2.3)**

<table>
<thead>
<tr>
<th><strong>Name</strong></th>
<th>Enter the name as it should appear in the recipients e-mail program. This can be your name or someone else's name.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>E-mail address</strong></td>
<td>Enter the e-mail address that the recipient can reply to by pressing the reply button of his e-mail program. This can be your e-mail address, or someone else's address.</td>
</tr>
<tr>
<td><strong>Recipients</strong></td>
<td>Enter the e-mail addresses of the intended recipients. Pressing the &quot;add&quot; button will bring up a new entry window where you can enter a recipient's name and e-mail address. You can also highlight a recipient's name and edit the data or remove it from the list.</td>
</tr>
<tr>
<td><strong>Subject Line</strong></td>
<td>Text entered in this line will be displayed in the subject line of the e-mail when displayed on the recipients' e-mail programs. Clicking on the button will allow you to specify some file related information which will be entered into the subject line at the time of sending. You can enter your own text with the file related information.</td>
</tr>
<tr>
<td><strong>Advanced settings</strong></td>
<td>Press this button to display a new dialogue window where you can enter advanced SMTP settings like port numbers, retries and log files. Refer to the section about Advanced SMTP settings (on page 114).</td>
</tr>
<tr>
<td><strong>Attach file in the following formats</strong></td>
<td>Select all files that you wish to attach when the e-mail is sent. Each file ticked here will be created, regardless of the settings made in &quot;EDIT - OPTIONS - EXPORTS AND REPORTS&quot;.</td>
</tr>
<tr>
<td><strong>Store pending uploads between sessions</strong></td>
<td>This check box is ticked by default. If a file send is interrupted due to a network error LogTag Analyzer will re-attempt to send the file when it is next started. If the feature is disabled, any files not sent when the software is closed will have to be manually re-submitted.</td>
</tr>
</tbody>
</table>

As a minimum you only need to provide an SMTP server address and one recipient e-mail address for this function to work.

Every time you make changes to these settings you should perform a test by pressing the "Send Test e-mail" button. LogTag Analyzer will
- check you have provided valid connection data,
- send a test e-mail to the e-mail addresses in the recipient list.
If any of these actions fail, LogTag Analyzer will display one of the following error messages:

In this case the SMTP server requires authentication, and the data provided were not correct. Please enter the correct authentication data.

This error message is displayed if LogTag Analyzer could not connect to the specified SMTP site because it could not find it. This could be due to internet connectivity issues, due to an incorrect port name or due to a mis-spelt server name.

This error message is displayed if one or more of the addresses in the recipient list have an incorrect mail format (i.e. are not in the format a@b.c). LogTag Analyzer can only check for the correct format of the addresses, but not for correctness of the recipients e-mail addresses. Please note if you do not provide a correct return address, you may not know that intended recipients are not receiving the messages.

We recommended you add your own e-mail address to the list of recipients. This way you get feedback if your e-mail has been sent correctly in your e-mail program. It is also good practice to enter a valid and correct e-mail return address for yourself. Some ISP’s will not relay messages without a sender’s address.
Advanced SMTP settings

Clicking on the "Advanced Settings" button in the SMTP settings dialogue displays following Window:

This will allow experienced users to change additional settings normally associated with FTP transfers.

<table>
<thead>
<tr>
<th>Field</th>
<th>What to enter</th>
</tr>
</thead>
</table>
| Port Number                  | The default port for providing SMTP connections is 25. Some network administrators change the port number on their SMTP servers to increase security and stop hacking attacks. If your network administrator has advised a different port for connection, please enter it here.  
In this case you may also need to change the settings of your firewall.  
If you wish to learn more about this topic please see any of the published articles on networking and TCP/IP available on the Internet. |
| Retry                        | If a connection cannot be established, LogTag Analyzer will retry to e-mail the file again after the number of minutes entered here. This helps eliminate e-mail errors due to intermittent Internet connection errors.                      |
| Maximum Retries              | Enter the number of times LogTag Analyzer should try to e-mail the file if previous attempts have not been successful.                                                                                     |
| Automatic Disconnect if idle | LogTag Analyzer will keep the connection to the SMTP server active, even if currently no files are being e-mailed. This avoids having to exchange password and login information every time a file is uploaded therefore providing faster uploads, especially if only a slow Internet connection is available. After a certain amount of inactivity the connection is dropped to save resources. Enter the time after which you wish LogTag Analyzer to automatically disconnect from the SMTP server. |
Log uploads
If a tick is placed in the box next to "Log uploads" the message exchange between the SMTP server and LogTag Analyzer is recorded into a file. These files are automatically named "YYYY_M_D_LogTag Analyzer_SMTP.log", you can specify a location where the files are created, or click to browse to a location of your choice.

Log Connection errors
Tick this box if you wish connection errors to be logged. This is recommended if you frequently experience upload errors and you wish to discuss this issue with your network administrator.

Click OK to store the settings or cancel to abort.

**Basic FTP settings**

You will require two main pieces of information to upload data to an FTP site:

- The name of the FTP site and a directory on the site in which the files will be stored once uploaded and
- A valid user name and password allowing you access to this directory.

Once you have clicked the "FTP Settings" button a dialogue window will appear, allowing you to enter the configuration data for the FTP site access.

![FTP Settings](image)

**Figure 39: Basic FTP settings**

If you have been supplied with access data by your network administrator we suggest you print this page, enter the data into the fields provided and keep it in a safe place.

<table>
<thead>
<tr>
<th>Field</th>
<th>What to enter</th>
<th>Your details</th>
</tr>
</thead>
<tbody>
<tr>
<td>FTP Server</td>
<td>Enter the name of the FTP site you were given by your network administrator</td>
<td></td>
</tr>
<tr>
<td>User Name</td>
<td>Enter the user name you have been allocated by your network administrator</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Password</td>
<td>Enter the password you have been given by your network administrator.</td>
<td></td>
</tr>
<tr>
<td>Remote folder</td>
<td>Enter the folder in which the data files should be uploaded. Please note that not all FTP servers allow creation of files or folders in the root directory. Please discuss any of your requirements with your network administrator.</td>
<td></td>
</tr>
<tr>
<td>Create Folder</td>
<td>Tick this box if the remote folder is not yet present on the FTP site and you wish to create it.</td>
<td></td>
</tr>
<tr>
<td>Upload file in the following formats</td>
<td>Select all files that you wish to have uploaded to the FTP site. Each file ticked here will be created, regardless of the settings made in &quot;EDIT - OPTIONS - EXPORTS AND REPORTS&quot;.</td>
<td></td>
</tr>
<tr>
<td>Advanced settings</td>
<td>Press this button to display a new dialogue window where you can enter advanced FTP settings like port numbers, retries and log files. Refer to the section about Advanced FTP settings (on page 117).</td>
<td></td>
</tr>
<tr>
<td>Store pending uploads between sessions</td>
<td>This check box is ticked by default. If a file upload is interrupted due to a network error or because the FTP site is temporarily unavailable, LogTag Analyzer will re-attempt to upload the file when it is next started. If the feature is disabled, any files not uploaded when the software is closed will have to be manually re-submitted.</td>
<td></td>
</tr>
</tbody>
</table>

All of the above settings are required to make a successful connection to an FTP server.

Every time you make changes to these settings you should perform a test by pressing the "Test connection" button. LogTag Analyzer will

- check you have provided valid connection data,
- if necessary create the folder you have specified and
- put a small test file in the selected location.

If any of these actions fail, LogTag Analyzer will display one of the following error messages:

![FTP: Unable to create remote folder data files.](image.png)

In this case the remote folder could not be created. Please select a different folder name or change to a permitted location.
This error message is displayed if LogTag Analyzer could not connect to the specified FTP site because it could not find it. This could be due to internet connectivity issues, due to an incorrect port number or due to a mis-spelt name.

This message appears when either user name or password are incorrect.

**Advanced FTP settings**

Clicking on the "Advanced Settings" button in the FTP settings dialogue displays following Window:
This will allow experienced users to change additional settings normally associated with FTP transfers.

<table>
<thead>
<tr>
<th>Field</th>
<th>What to enter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port Number</td>
<td>The default port for providing FTP connections is 21. Some network administrators change the port number on their FTP servers to increase security and stop hacking attacks. If your network administrator has advised a different port for connection, please enter it here. In this case you may also need to change the settings of your firewall. If you wish to learn more about this topic please see any of the published articles on networking and TCP/IP available on the Internet.</td>
</tr>
<tr>
<td>Security Protocol</td>
<td>Choose between none, SSL or TSL 1.0</td>
</tr>
<tr>
<td>Firewall/Proxy Settings</td>
<td>Use the settings from the registry or choose your own settings. Please discuss these settings with your network or IT administrator.</td>
</tr>
<tr>
<td>Retry</td>
<td>If a connection cannot be established, LogTag Analyzer will retry the file upload after the number of minutes entered here. This helps eliminate upload errors due to intermittent Internet connection errors.</td>
</tr>
<tr>
<td>Maximum Retries</td>
<td>Enter the number of times LogTag Analyzer should try to upload the file if previous attempts have not been successful.</td>
</tr>
<tr>
<td>Automatic Disconnect if idle</td>
<td>LogTag Analyzer will keep the connection to the FTP server active, even if currently no files are being uploaded. This avoids having to exchange password and login information every time a file is uploaded therefore providing faster uploads, especially if only a slow Internet connection is available. After a certain amount of inactivity the connection is dropped to save resources. Enter the time after which you wish LogTag Analyzer to automatically disconnect from the FTP server.</td>
</tr>
<tr>
<td>Log uploads</td>
<td>If a tick is placed in the box next to &quot;Log uploads&quot; the message exchange between the FTP server and LogTag Analyzer is recorded into a file. These files are automatically named &quot;YYYY_M_D_LogTag Analyzer_FTP.log&quot;, you can specify a location where the files are created, or click to browse to a location of your choice.</td>
</tr>
<tr>
<td>Log Connection errors</td>
<td>Tick this box if you wish connection errors to be logged. This is recommended if you frequently experience upload errors and you wish to discuss this issue with your network administrator.</td>
</tr>
</tbody>
</table>

Click OK to store the settings or cancel to abort. You can restore default settings by clicking on "Restore defaults".
File and Folder Settings

The File and Folder Settings options help you manage the LogTag data files.

Display X items in my most recently used list

This determines how many of the most recently accessed files are listed in the "File (see "File Menu" on page 131)" menu for quick access to be opened and viewed again. Once this number of files has been reached, the reference to the oldest file opened will be removed and the most recently opened file will be added to position 1. Only the file reference is removed from this list, the actual file is not deleted. Changing this setting will take effect the next time LogTag Analyzer is started.

Display

This determines how the information retrieved from a file and/or LogTag will be first displayed. All other ways of displaying information will still be available regardless of which is selected here.

- Chart; this will display the data in a time versus humidity and/or temperature chart.
- Data; this will display a list grid (spreadsheet style) of the time versus humidity and/or temperature data.
- Report; this will display a condensed overview of the data including averages, ranges, alert results, LogTag identification data, and a small chart.
- Summary; this will display a summary of the data, including averages, ranges, alert results, LogTag identification data, and other information.

File Name

Whenever information is retrieved from a LogTag it is always automatically saved to disk. This entry determines the method to be used to create a meaningful name of the file that will contain the data downloaded from the LogTag.
The button at the end of the edit control ( ) can be used to assist you with defining how file names are to be created by inserting the appropriate predefined element that matches the information you want to use. Clicking on this button will display a popup list, similar to the following picture to allow you select from the available elements.

To customize how the file name is created, you may use one or more of the available elements in any order. If you use spaces to separate the elements, these spaces will appear in the same location in the name of the file created. The letters must be in uppercase or lowercase as shown in the following table (for example, “%ID” not “%id”) and all elements must be preceded by % if specified. Other characters that are included will appear in the same location and unchanged in the file name creation.

<table>
<thead>
<tr>
<th>Element</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>%DATE</td>
<td>The date when the LogTag information was originally retrieved.</td>
</tr>
<tr>
<td>%DATE-TIME</td>
<td>The date and time when the LogTag information was originally retrieved.</td>
</tr>
<tr>
<td>%FINISH</td>
<td>The date and time of the last reading recorded after being started. If the LogTag was not started then this information will be blank.</td>
</tr>
<tr>
<td>%FINISH-DATE</td>
<td>The date of the last reading recorded after being started. If the LogTag was not started then this information will be blank.</td>
</tr>
<tr>
<td>%FINISH-TIME</td>
<td>The time of the last reading recorded after being started. If the LogTag was not started then this information will be blank.</td>
</tr>
<tr>
<td>%FIRST</td>
<td>The date and time of when the LogTag began recording information, even if it was under pre-start conditions.</td>
</tr>
<tr>
<td>%FIRST-DATE</td>
<td>The date of when the LogTag began recording information, even if it was under pre-start conditions.</td>
</tr>
<tr>
<td>%FIRST-TIME</td>
<td>The time of when the LogTag began recording information, even if it was under pre-start conditions.</td>
</tr>
<tr>
<td>%ID</td>
<td>The unique LogTag identification value.</td>
</tr>
<tr>
<td>%LAST</td>
<td>The date and time of the last reading recorded, even if there are only pre-start recordings.</td>
</tr>
<tr>
<td>%LAST-DATE</td>
<td>The date of the last reading recorded, even if there are only pre-start recordings.</td>
</tr>
<tr>
<td>%LAST-TIME</td>
<td>The time of the last reading recorded, even if there are only pre-start recordings.</td>
</tr>
</tbody>
</table>
Customising the software

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>%PRODUCTID</td>
<td>The product identifier (part number) for the LogTag used to record the data.</td>
</tr>
<tr>
<td>%SERIALNUM</td>
<td>The unique serial number of the LogTag.</td>
</tr>
<tr>
<td>%START</td>
<td>The date and time the LogTag was started to record information. If the LogTag was not actually started and only pre-start information was recorded then this information will be blank.</td>
</tr>
<tr>
<td>%START-COUNT</td>
<td>The number of times the LogTag has been started since manufacture.</td>
</tr>
<tr>
<td>%START-DATE</td>
<td>The date the LogTag was started to record information. If the LogTag was not actually started and only pre-start information was recorded then this information will be blank.</td>
</tr>
<tr>
<td>%START-TIME</td>
<td>The time the LogTag was started to record information. If the LogTag was not actually started and only pre-start information was recorded then this information will be blank.</td>
</tr>
<tr>
<td>%TIME</td>
<td>The time when the LogTag information was originally retrieved.</td>
</tr>
<tr>
<td>%USERID</td>
<td>The user defined identifier for the set of information recorded by the LogTag.</td>
</tr>
</tbody>
</table>

You may use the \ character to specify that a file name definition includes a sub folder name as well as the actual file name, which is useful if you want to group/sort files automatically together, for example, by date or by User Id.

Each of the following elements within the quotes (") are not permitted, as they are not supported the operating system ": * ? < > |". If you do include one of these elements in the definition of how the file names are to be created they will be replaced with the _ character.

If you use a date and/or a time element, the format of that element will be determined by the settings defined in the "Date and Time (see "Dates and Times" on page 125)" set of options.

**Folder Name**

This determines the location where the files are automatically stored. The location defined here can specify a local drive path or a network drive path. UNC folder names are supported. The button at the end of the edit control will assist you to locate the default store folder by browsing the folder structure available to you, if you choose to use it.

Since this is the default location where files are stored, this also represents the default folder that will be used when searching for files to open (through the Open command in the File menu).

You can also use the PC's environment variables to compose a user specific pathname. This is particularly of interest to network administrators who wish to create silent installations and create generic UserProfile.dat files to direct the data to a location on the local PC or a domain server.

You can insert these variables at any location in the path name, provided the final resulting name is a valid UNC folder name. Use the button to insert following variables at the cursor:
<table>
<thead>
<tr>
<th>Variable</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>%COMPUTERNAME</td>
<td>The name of the computer as entered in the system description.</td>
</tr>
<tr>
<td>%USERDOMAIN</td>
<td>The domain name of the network the user is connected to.</td>
</tr>
<tr>
<td>%HOMEDRIVE</td>
<td>The drive letter on which the User’s documents directory is stored.</td>
</tr>
<tr>
<td>%HOMEPATH</td>
<td>The path (excluding the drive letter) of the user’s home directory.</td>
</tr>
<tr>
<td>%USERNAME</td>
<td>The user’s user name as required for logon.</td>
</tr>
</tbody>
</table>

A valid storage directory would be "%HOMEDRIVE%HOMEPATH\Documents\My LogTag Data".

Note: Some Network Attached Storage Devices (NAS Drives) use versions of SAMBA (Server Message Block) file servers which do not correctly report back whether a file exists or not. Consequently, LogTag Analyzer will overwrite without warning an already existing file with the same name, regardless of the settings made in the Automation on page 107 options.

**Uniqueness**

This determines how the software will manage information retrieved from a LogTag when a file of the same name already exists. For example, when you retrieve the information from the same LogTag once every day, while the LogTag is still recording and the LogTag has not been prepared for its next use and started again. The options available include:

1. **Always create a unique copy of files (recommended)**
   - If a file of the same name already exists, then the software will automatically append "Copy n" to the end of the file name, where "n" will be a unique number.

2. **Overwrite file if the file already exists**
   - If a file of the same name already exists, the existing file is overwritten (deleted and replaced) with a file that contains the information just retrieved from a LogTag.

3. **Prompt if an existing file already exists.**
   - If a file of the same name already exists, then you will see a message appear asking you whether or not you want to overwrite and replace the existing file with the information just retrieved from the LogTag.
   - If you answer "Yes" then the action described in the option "Overwrite file if the file already exists", previously explained, will be performed.
   - If you answer "No" then the action described in the option "Always create a unique copy of files (recommended)", previously explained, will be performed.
Exports and Reports

In addition to the native *.ltd file you can automatically create files in other formats every time a LogTag is downloaded. You would use this for example if you wanted to perform further analysis of the downloaded data in MS Excel, or e-mail a PDF file to someone who does not have LogTag Analyzer installed on their computer.

To automatically create an additional file of a different type, place a check mark in the tick box next to the file type in the list. You can select more than one additional file type.

- Text (Tab delimited)
- Text (Macintosh)
- CSV (Comma delimited)
- HTML
- PDF (Portable Document Format)

The additional files will be automatically saved when downloading a LogTag using the file name and folder location defined in the "File and folder settings (on page 119)" options. If during the download no new file is created (for example when downloading a unit that has previously been downloaded), no export data are generated either.

These file formats cannot be imported back into LogTag Analyzer. It is also not possible to detect any manipulation to these files since they can be edited with third party software.
You can select which extra information will be included in the exported data by highlighting the format name and clicking [Customize...]. In the dialogue window displayed adjust the options to suit and click OK to save your selection. Click cancel if you wish to discard any changes you have made.

![Properties dialog window]

For CSV files you can additionally select a custom list separator. CSV files normally use a comma as a separator between individual values of a row. By default, LogTag Analyzer uses the list separator from the "Regional and Language Options" in the Windows Operating System. For some regions the resulting file is strictly speaking no longer a CSV file, however it maintains compatibility with the import of CSV files into MS Excel. You can also use a self selected separator instead.

The options for the PDF files are more extensive than for other files, please see PDF files on page 60.

To select file formats for the e-mail attachment created through the Send Mail command when Sending a file by e-mail direct from Analyzer on page 95, tick the desired file formats in the second list. The list of Send Mail file formats contains only file formats selected in the Export formats list, plus the LogTag Analyzer format.

None of the formats selected here will be automatically uploaded to an FTP site, or e-mailed through the automatic e-mailing function. Files to be automatically sent or uploaded are enabled in the Basic FTP settings on page 115 and the Basic SMTP and e-mail settings on page 110 dialogues. Customisation, however, is only performed in the section about Exports and Reports.
Dates and Times

The Date and Time options allow how the date and time information is displayed by the software to be overridden. It does not affect how the date and time information is stored and therefore, how the date and/or time information is shown can be changed at any time. At the bottom of this option window, a sample of the date and time using the formats selected will be displayed.

To customize how the date information is displayed, the following elements may be used. If spaces are used to separate the elements, these spaces will appear in the same location in the date displayed. The letters must be in uppercase or lowercase as shown in the following table (for example, "MM" not "mm"). Characters that are enclosed in single quotation marks will appear in the same location and unchanged in the date displayed.

<table>
<thead>
<tr>
<th>Element</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>d</td>
<td>Day of month as digits with no leading zero for single-digit days.</td>
</tr>
<tr>
<td>dd</td>
<td>Day of month as digits with leading zero for single-digit days.</td>
</tr>
<tr>
<td>ddd</td>
<td>Day of week as a three-letter abbreviation.</td>
</tr>
<tr>
<td>dddd</td>
<td>Day of week as its full name.</td>
</tr>
<tr>
<td>M</td>
<td>Month as digits with no leading zero for single-digit months.</td>
</tr>
<tr>
<td>MM</td>
<td>Month as digits with leading zero for single-digit months.</td>
</tr>
<tr>
<td>MMM</td>
<td>Month as a three-letter abbreviation.</td>
</tr>
<tr>
<td>MMMM</td>
<td>Month as its full name.</td>
</tr>
<tr>
<td>y</td>
<td>Year as last two digits, but with no leading zero for years less than 10.</td>
</tr>
<tr>
<td>yy</td>
<td>Year as last two digits, but with leading zero for years less than 10.</td>
</tr>
<tr>
<td>yyyy</td>
<td>Year represented by full four digits.</td>
</tr>
</tbody>
</table>

To customize how the time information is displayed, the following elements may be used. If spaces are used to separate the elements, these spaces will appear in the same location in the time displayed. The letters must be in uppercase or lowercase as shown in the following table (for example, "ss", not "SS"). Characters that are enclosed in single quotation marks will appear in the same location and unchanged in the time displayed.
<table>
<thead>
<tr>
<th>Element</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>h</td>
<td>Hours with no leading zero for single-digit hours; 12-hour clock.</td>
</tr>
<tr>
<td>hh</td>
<td>Hours with leading zero for single-digit hours; 12-hour clock.</td>
</tr>
<tr>
<td>H</td>
<td>Hours with no leading zero for single-digit hours; 24-hour clock.</td>
</tr>
<tr>
<td>HH</td>
<td>Hours with leading zero for single-digit hours; 24-hour clock.</td>
</tr>
<tr>
<td>m</td>
<td>Minutes with no leading zero for single-digit minutes.</td>
</tr>
<tr>
<td>mm</td>
<td>Minutes with leading zero for single-digit minutes.</td>
</tr>
<tr>
<td>s</td>
<td>Seconds with no leading zero for single-digit seconds.</td>
</tr>
<tr>
<td>ss</td>
<td>Seconds with leading zero for single-digit seconds.</td>
</tr>
<tr>
<td>t</td>
<td>One character time-marker string, such as A or P.</td>
</tr>
<tr>
<td>tt</td>
<td>Multi character time-marker string, such as AM or PM.</td>
</tr>
</tbody>
</table>

For example, if the date was 2 January 2004 and the date format was defined as "yy-M,'; dd" (excluding the double quotes) the date would be displayed as "04-1, 02".

### Time zones

The time zone of the computer used to configure a LogTag is stored in the LogTag's memory. In some cases, the configuration time zone will be different from the time zone at the download location. This allows you to select which time zone will be used to display dates and times within the chart, summary and data displays. This option will not have any effect on the original recorded data.

| Download Time Zone | All reading times are displayed in the time zone of the computer used for downloading/displaying the data. This is the default setting. |
| Configuration Time Zone | All reading times are displayed in the time zone of the computer used for configuring the LogTag. |
| UTC/GMT Time Zone | All times are displayed in Universal Time Coordinates, or Greenwich Mean Time representation. |
| Logger Display Clock / Configuration Time Zone | All times are displayed relative to the clock that is showing on the display. If the unit has no display, the logger's Configuration time zone is used. |
| Logger Display clock/Download Date | All times are displayed relative to the clock that is showing on the display and use the date of the download computer. |
**Communication Ports**

In this dialogue you define, which communication ports have interface cradles connected. This allows ports not used for communicate with LogTag products to be excluded, which speeds up communication.

The software checks all enabled communication ports at the same time, so using multiple communication ports will not affect the performance of the software significantly. As the software supports multiple communication ports, it is possible to connect and use to more than one interface cradle at the same time.

![Communication Ports dialog box](image)

**Note:** USB ports cannot be disabled; if you do not wish the software to communicate with USB ports you must unplug any interface connected.

**User Server**

The User Server options define if and where the software should connect to the LogTag User Server software. If you do not have LogTag User Server software installed on your computer and/or available on your local area network, you will not need to make any changes to this set of options. Connection to the LogTag User Server software is typically only used within a multiple computer user environment or if your organization requires compliance with the US FDA 21 CFR Part 11 regulations, for use of digital signatures that are controlled by a central administrator.

![User Server dialog box](image)
The settings required in these fields will be provided by your network administrator. Once a valid connection to the LogTag User Server software has been established, you will be required to log on (see "How users log on" on page 144) to the software to continue using it.

Note: If the LogTag User Server software runs on a different computer you need to be connected to that computer via a LAN or WAN to use LogTag Analyzer software or make any changes to these settings.

To enter or change these settings, LogTag Analyzer must be started from a user account with local administrator privileges. If you normally start it from a standard user account, please close LogTag Analyzer, right click its shortcut and click "Run as administrator" from the context menu. Make the changes after you have provided Administrator credentials, then close LogTag Analyzer and start as usual.

![Figure 40: Running LogTag Software as administrator](image)

**Software Updates**

The LogTag Analyzer software can periodically check if a newer version is available for download from the LogTag Recorders website.

You can turn this feature On or Off by selecting the corresponding button, and set the number of days between checks by entering a number in the "Check every XX days" field.

If you select On, you will be asked if you want a web browser to open a website with the latest download link whenever a new version is available.

If the "Automatic Update" setting is enabled, you will be taken to this site without further notification.
Configuration Reports

It can sometimes be useful to keep a record of the configuration data of a LogTag Recorder. LogTag Analyzer allows a number of selected configuration data to be stored in a text file. These settings are made in the Configuration Reports window.

When the "Log configuration data" option is ticked, the selected parameters are written into a text file, which is named "LogTag Analyzer_config_log_WW-YYYY", where WW is the current week number and YYYY is the current year. Each week a new file will be generated.

Clicking on the button will allow you to select a folder of your choice where the log files will be stored. For each logger configured a new line is started in the text file, individual entries in each line are separated by the character specified in the "Field separator" box. You can change the order of the entries in each line by selecting a Field and clicking on the up or down buttons. Clicking the tick box enables all parameters to be included in the log file.

Following parameters can be selected:

- Name
- Time
- Logger ID
- User ID
- Restart Enabled
- Loop Log Memory
- Start Method
- Log Duration
- Log Interval
- Log Count
- Lower Alarm(L)
- Upper Alarm(U)
- Cumulative Alert
- Non Consecutive Alert
- Loop Alert
- Clear Alert
- Configure Requires Password
- Download Requires Password
At the top of the screen for the LogTag Analyzer, just below the title bar, which contains the name of the software, is the menu system and toolbar for the software. The toolbar provides quick access to some of the more commonly used functions within the menu system. The menu system contains lists of all the operations and commands that are available to you while using the software.

**In This Chapter**

- Menu commands .......................................................... 131
- Toolbar commands ....................................................... 137
- Print preview toolbar .................................................... 139
- Standard Window commands ............................... 140
Menu commands

The menu system has been separated into groups of related commands. Each of these menu groups is explained in more depth in the subsequent sections. The software will only display the menu groups and commands within each menu group that are appropriate depending on what you are currently doing with the software.

You may also see that some of the menu commands have a reference after the command name, for example F2 or Ctrl+O. These represent key strokes on the keyboard that instruct the software to perform the appropriate command, without the need to select the menu or toolbar command. When only one key reference is mentioned, for example "F2", then pressing that single key on the keyboard will cause the appropriate command to be performed. If there is more than one key reference mentioned, for example Ctrl+O, then to cause the command to be performed you must press and hold down the first key mentioned while pressing the other key once. When letters are used in the key reference, for example Ctrl+O, it does not matter whether or not the caps lock is on or off.

File Menu

The "File" menu contains commands that generally relate to a LogTag file as a whole. A LogTag file contains a variety of information that relates to a data set representing readings that were recorded over a discrete period of time by a single LogTag. The File menu will appear similar to the following picture.

The following table outlines the commands and the explanation of each command that may appear in the "File" menu when using the LogTag Analyzer software:
<table>
<thead>
<tr>
<th>Command</th>
<th>Explanation</th>
</tr>
</thead>
</table>
| **Open** (see "Calling up previous results" on page 96)... | This will display the Open file dialog, which will allow you to open:  
  - LogTag files that contain readings previously retrieved, or  
  - previously saved Multi Chart configuration files.  
  It will start at the folder defined in the File and Folder Settings (on page 119) section in the Options (see "Customising the software" on page 102).  
  If a Multi Chart file is selected, the LogTag Analyzer software will automatically switch to Multi Chart mode and all the selected files will be added to the Multi Chart display. |
| **Close**        | This command will close all windows that are displaying information about the open file that is currently selected. If no files are currently open this command will not be visible. |
| **Multi Chart**  | This will change the way recordings are displayed such that they are all combined on a single chart window (see Combining Charts into a single chart on page 80). |
| **Single Chart** | This will change the way recordings are displayed such that each which will contain all the information retrieved from a single LogTag. |
| **Save**         | This will save any changes you have made to the LogTag file (or Multi Chart configuration) to your disk drive. |
| **Save As...**   | This will display the Save As file dialog, which will allow you to save a copy of the file currently being displayed in the same or different folder with the same or different file name. |
| **Upload**       | This will send an e-mail with the currently active file attached to a list of recipients or upload the file to a pre-determined FTP site. See Automatic e-mailing and uploading to FTP sites on page 108. |
| **Print** (see "Printing the results" on page 94)... | This will open a window allowing you to print a copy of the LogTag file to an output device, which will typically be a printer. This command is further explained in the section "Printing the results (on page 94)". |
| **Print Preview** (see "Print preview toolbar" on page 139) | This will change the display mode of the software to show you a copy of how a printout of the currently selected file and window would look like. In "Print Preview" mode you will not be able to zoom in or out of a chart. Click to exit the "Print Preview" mode and return to normal display mode. |
| **Print Setup...** | This will open a window allowing you to view and/or adjust one or more of your printer's settings. |
| **Page Setup...** | This will open a window allowing you to view and/or adjust one or more of your page settings, like printer margins and page orientation. |
| **Send** on page 95... | This will help you send, by e-mail, the currently open and selected LogTag file to another user without the need to exit to your e-mail software or to deal with file attachments. This command is explained in further detail in the section "Sending a file by e-mail direct from Analyzer on page 95". |
| **Properties** (see "Viewing file properties" on page 100)... | This will open a window that will display the information about the file that is being displayed and currently selected. This same window and information will be displayed if you view the properties of the file from Microsoft Windows Explorer. |
### Digital Signature

This will open a window to display a list of digital signatures that have been included with the file. It also allows you to add and print this list of digital signatures. This command is explained in further detail in the section "Digital signatures (on page 97)."

### User logon

This allows a user to logon to and use the Analyzer software. When the software is connected to the User Server software, users must logon to the software prior to being permitted to use the software. Therefore, this command will only be available if the Analyzer software is connected to the User Server software. If a user is already logged on to the software, then this command is not visible. The section "User Server (on page 127)" explains in more detail how to get the Analyzer software to connect to the User Server software.

### Logoff user (username)

This allows the currently logged on user to logoff the Analyzer software. The *username* portion of this command will represent the name of the user currently logged on. If there is no currently logged on user, this command is not visible.

### Change Password

This allows the currently logged on user to modify their password that they use to logon to the Analyzer software. This command will only be available if the Analyzer software is connected to the User Server software and the User Server administrator has granted the appropriate user permissions.

### 1, 2, 3, etc

This portion of the menu represents a list of the most recently files you have viewed. To reopen one of these files, simply click on the entry (name of the file) to open. If a file that you want to view is not included in this list, you may use the "Open..." command included in this menu. The number of files included in this list can be adjusted through the "General Settings (on page 104)" section of the Options (see "Customising the software" on page 102).

### Exit

This command will exit and close down the LogTag Analyzer software. Any files that you currently have open will also be closed automatically for you. If a user is currently logged on to the Analyzer software when the Analyzer closes, the user will be automatically logged off.

---

### Edit Menu

The "Edit" menu contains commands that generally relate to the contents of a LogTag file and will appear similar to the following picture.

The following table outlines the commands and the explanation of each command that may appear in the "Edit" menu when using the LogTag Analyzer software:
<table>
<thead>
<tr>
<th>Command</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy (CTRL+C)</td>
<td>Places a copy of the contents of the currently displayed window onto the clipboard, which can then be pasted into any Windows® application. If you are copying a chart, the chart at its current zoom range is copied to the clipboard. If you are copying from one of the tabular style windows (Data or Summary), then the entire contents of the window is copied to the clipboard, regardless of what part of the data you have scrolled to view.</td>
</tr>
<tr>
<td>Zoom Out (CTRL+)</td>
<td>This will undo the last zoom operation performed allowing you to see more of the data on the chart. If the chart is displaying all the readings recorded by the LogTag, this command will not be available.</td>
</tr>
<tr>
<td>Real time (CTRL+R)</td>
<td>Clicking this menu item will make the time axis represent date and time the data were recorded. This is useful when you want to inspected at what date and time a certain event occurred.</td>
</tr>
<tr>
<td>Elapsed time (CTRL+E)</td>
<td>Clicking this menu item will make the time axis represents the elapsed time since the recording began. This is useful when you want to inspected how long into a trip a certain event occurred.</td>
</tr>
<tr>
<td>Zoom to Marks (CTRL+M)</td>
<td>When this command is enabled, the chart is automatically zoomed to show readings recorded between inspection marks. The section &quot;Starting and using the LogTag (on page 25)&quot; explains in further detail how inspection marks are recorded.</td>
</tr>
<tr>
<td>Previous group of Marks (CTRL+P)</td>
<td>This command will show the readings recorded between the first inspection mark shown and the previous inspection mark recorded. This command will only be available if the &quot;Zoom to Marks&quot; command is enabled and the first reading recorded is not currently visible.</td>
</tr>
<tr>
<td>Next group of Marks (CTRL+N)</td>
<td>This command will show the readings recorded between the last inspection mark shown and the next inspection mark recorded. This command will only be available if the &quot;Zoom to Marks&quot; command is enabled and the last reading recorded is not currently visible.</td>
</tr>
<tr>
<td>Options (see &quot;Customising the software&quot; on page 102) (CTRL+O)</td>
<td>This will open a window allowing you to customize the software. This command is further explained in the chapter &quot;Customizing the software&quot; (see &quot;Customising the software&quot; on page 102).</td>
</tr>
</tbody>
</table>

**LogTag Menu**

The "LogTag" menu contains commands that generally relate to the usage and interaction with LogTags.

![Figure 41: Menu bar - LogTag Menu](image)
The following table outlines the commands and the explanation of each command that may appear in the "LogTag" menu when using the LogTag Analyzer software:

<table>
<thead>
<tr>
<th>Command</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure...</td>
<td>This will display a wizard to help you through the necessary steps to prepare LogTags for their next use. This command is explained in further detail in the chapter &quot;Preparing LogTags for use on page 29&quot;.</td>
</tr>
<tr>
<td>Download...</td>
<td>This will display a wizard to help you through the necessary steps to retrieve a copy of the recorded readings stored within the LogTag(s). This command is explained in further detail in the chapter &quot;Results from LogTag (on page 55)&quot;.</td>
</tr>
<tr>
<td>Hibernate...</td>
<td>This will display a wizard to help you through the necessary steps to set LogTags to &quot;Hibernation&quot; mode. This command is explained further in the chapter &quot;Prolonging battery life (see &quot;Hibernation - Prolonging battery life&quot; on page 52)&quot;.</td>
</tr>
<tr>
<td>Quick Re-configure...</td>
<td>With this command you can re-configure a logger with the same settings as for the previous trip. This command is explained in further detail in the section &quot;Quickly re-configuring LogTags&quot; (see &quot;Quickly re-configuring LogTags&quot; on page 51)&quot;.</td>
</tr>
<tr>
<td>Profiles...</td>
<td>With this command you can configure a logger with a configuration profile previously created. This command is explained in further detail in the section about &quot;Configuration Profiles (on page 47)&quot;.</td>
</tr>
<tr>
<td>Wizard</td>
<td>This will display a wizard to help you through the necessary steps to retrieve a copy of the recorded readings stored within the LogTag(s) and then prepare the LogTags for their next use. This command is explained in further detail in the chapter &quot;Quick Start Guide (on page 17)&quot;.</td>
</tr>
</tbody>
</table>

**Window Menu**

The "Window" menu contains commands that relate to the management of each Window open within the LogTag Analyzer software that displays the contents of a LogTag file.

The following table outlines the commands and the explanation of each command that may appear in the "Window" menu when using the LogTag Analyzer software:

<table>
<thead>
<tr>
<th>Command</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Window</td>
<td>Opens a new window that contains a copy of the information of the currently selected window. This command is useful when you need to closely inspect and analyze different sections of the same data set.</td>
</tr>
</tbody>
</table>
Close
Closes the currently selected window within the LogTag Analyzer software.

Close All
Closes all the windows within the LogTag Analyzer software.

Cascade
Arrange all the windows within the LogTag Analyzer software in an overlapping style.

Title Horizontally
Arrange all the windows within the LogTag Analyzer software as horizontal non-overlapping tiles.

Title Vertically
Arrange all the windows within the LogTag Analyzer software as vertical non-overlapping tiles.

Arrange Icons
Arrange all the minimized windows within the LogTag Analyzer software at the bottom of the main window.

1, 2, 3, etc
The tick mark beside these entries indicates the window that is currently selected. If you want to change the currently selected window to one of the windows listed, just click/select the appropriate entry on this list.

Help Menu
The "Help" menu contains commands that relate to providing you with help and assistance with using the LogTag Analyzer software.

The following table outlines the commands and the explanation of each command that may appear in the "Help" menu when using the LogTag Analyzer software:

<table>
<thead>
<tr>
<th>Command</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help Topics</td>
<td>Opens a window that contains the online help.</td>
</tr>
<tr>
<td>User Guide</td>
<td>Opens the online user guide for viewing. Requires Adobe Acrobat and/or Adobe Acrobat Reader software, version 4 or later, to be installed on the computer.</td>
</tr>
<tr>
<td>LogTag® Home Page...</td>
<td>This will open your default Internet browser software and display the LogTag Recorders Internet site, <a href="http://www.logtagrecorders.com">http://www.logtagrecorders.com</a>. This command requires that your computer be currently connected to the Internet to successfully display the LogTag Recorders Internet site.</td>
</tr>
<tr>
<td>Request help (see &quot;Getting more help&quot; on page 143)...</td>
<td>This will gather non personal information from your system to include in the e-mail to be sent to software support at LogTag Recorders, so that the support team will be informed of the relevant information about your system in order to provide you with quality and useful assistance. This command is explained in further detail in the chapter Getting more help (on page 143).</td>
</tr>
</tbody>
</table>
Check Internet for update...  This is a simple way of checking to see if there is a newer version of this software available for download. This command is explained in further detail in the chapter about Upgrading Analyzer on page 14.

About LogTag Analyzer (see "Finding your software version" on page 142)... (ё)

Display the version information about the LogTag Analyzer software that you are using.

---

### Toolbar commands

Each icon on the toolbar represents a unique command.

- **Access LogTag**
  
  This will bring up the LogTag Wizard, which will take you through the steps to retrieve readings from connected LogTag(s) and prepare them for their next use.

- **Open**
  
  This will display the file open window to allow you to locate and open LogTag files that contain previously retrieved LogTag readings.

- **Save**
  
  Save a copy of the LogTag data to a file on your disk drive.

- **Print**
  
  Opens the window that will allow you to print a copy of the LogTag data to a printer.

- **File properties**
  
  Displays file properties about the currently selected open file.

- **File digital signatures**
  
  Displays information about any digital signatures included in the currently selected open file, which is also allows where new digital signatures can be added to the file and where you can print a copy of the digital signatures.

- **Send mail**
  
  Creates a new blank e-mail for sending a copy of the currently selected open file as an attachment to a recipient of your choice.

- **Upload**
  
  Uploads the file in the currently active window to an FTP server, or sends it by e-mail. Please see Automatic e-mailing and uploading to FTP sites on page 108.

- **Copy**
  
  Places a copy of the currently displayed information to the Windows clipboard so that you can paste it into another Windows software package.
**Real time**

When this button is active, the time axis represents date and time the data were recorded. This is useful when you want to inspected at what date and time a certain event occurred.

**Elapsed time**

When this button is active, the time axis represents the elapsed time since the recording began. This is useful when you want to inspected how long into a trip a certain event occurred.

**Zoom out**

Zooms out one level of the chart in the currently active window. If you are displaying a chart and this function is not available, then all available data are already being displayed and you cannot zoom out any further.

**Zoom to inspection marks**

This zooms the chart so readings are shown between the oldest reading recorded and the first inspection mark that exists in the data. If this function is not available then there are no inspection marks in the data currently being displayed.

The next two commands will not be available until this command is activated.

**Previous inspection mark group**

This zooms the chart so readings are shown which were recorded between the first inspection mark currently being displayed and the previous inspection mark.

This function is disabled when either the oldest reading is already being displayed, or the "Zoom to inspection marks" function has not been activated.

**Next inspection mark group**

This zooms the chart so readings are shown which were recorded between the last inspection mark currently being displayed and the next inspection mark.

This function is disabled when either the newest reading is already being displayed, or the "Zoom to inspection marks" function has not been activated.

**Average**

Combines all open file windows into a single Multi Chart window and activates the average tab. If already in multichart, activates or disables the average tabs. It is recommended to deactivate this feature when processing large data sets, as Minimum, Maximum and Average Charts (see "Special Chart Tabs" on page 84) can require considerable memory and processor resources when activated.

**Multi Chart**

Switches into Multi Chart mode, which displays all currently open charts together in one window. If additional LogTag(s) are downloaded or more files opened, their data will be added to the Multi Chart window.

**Single Chart**

Switches into Single Chart mode. Each chart that is currently open will be displayed in its own window.

**Options**

This will open a window allowing you to customize the software. This command is further explained in the chapter "Customizing the software" (see "Customising the software" on page 102).

**Logon/Logoff user**

This will log a user on to the software if no user is currently logged on or log off the currently logged on user. This command will only be available if the software is connected to the LogTag User Server software.
Help

Click on this icon, then click on an area on the screen, and the help topic for this area will be displayed.

Print preview toolbar

The print preview feature, available through the File menu (on page 131), of the software will display copy of the data as it would be included on a print out. When the software is displaying a file in print preview mode, an additional toolbar will appear, similar to the following picture:

<table>
<thead>
<tr>
<th>Command</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print (see &quot;Printing the results&quot; on page 94)...</td>
<td>This will open a window allowing you to print a copy of the LogTag file to an output device, which will typically be a printer. This command is further explained in the section &quot;Printing the results (on page 94)&quot;.</td>
</tr>
<tr>
<td>Next Page</td>
<td>This will display the next page included in the print out. This button will be disabled if there are no more pages available to be displayed.</td>
</tr>
<tr>
<td>Prev Page</td>
<td>This will display the previous page included in the print out. This button will be disabled if there are no previous pages available to be displayed.</td>
</tr>
<tr>
<td>One Page</td>
<td>Selecting this button will change the display so that only one page is displayed at a time. Once this button is selected it will change to &quot;Two Page&quot;.</td>
</tr>
<tr>
<td>Two Page</td>
<td>Selecting this button will change the display so that two consecutive pages are displayed side by side at the same time. This button will be disabled if there is only one page in the print out, like a chart. Once this button is selected it will change to &quot;One Page&quot;.</td>
</tr>
<tr>
<td>Zoom In</td>
<td>This will zoom in the display of the print out making it appear larger on the screen. It will not affect what information is included in the print out.</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>This will zoom out the display of the print out making it appear smaller on the screen. It will not affect what information is included in the print out.</td>
</tr>
</tbody>
</table>
This will close the print preview mode of display and revert the display of the data back to normal mode, which will allow users to switch between chart display and data listing display, for example.

### Standard Window commands

In the top right corner of each window, one or all of the buttons in the following image will be displayed and will (from left to right) minimize the window, maximize the window or close the window.

The following picture illustrates an example of the menu that will appear if a user selects the icon in the top left corner of the LogTag Analyzer software, usually by clicking the left mouse button on it, or by clicking the right mouse button on the title bar (see “Menus and Toolbars” on page 130). The commands illustrated in the following picture allow you to change the location and/or size of the window containing the LogTag Analyzer software. Users can also move the window containing the LogTag Analyzer software by "dragging" the title bar, which is typically performed by pressing and holding the left mouse button down over the title bar of the software and moving the mouse to the new location for the window.
The following picture illustrates an example of the menu that will appear if a user selects the icon in the top left corner of a data file window, usually by clicking the left mouse button on it, or by clicking the right mouse button on the title bar (see "Menus and Toolbars" on page 130) of the data window. These menu commands will only affect the window containing the data retrieved from a LogTag rather than the Window that contains the entire LogTag Analyzer software.
Finding your software version

Within the "Help" (see "Help Menu" on page 136) menu, is the "About LogTag Analyzer..." command, which will display a Window similar to the following picture.

Figure 42: About LogTag window

Within this window, amongst other information, the full version number of the software being used is displayed. This information is useful, for example, to determine if the same software version is installed on multiple computers and/or if the user guide being referenced refers to the version of software being used.

For example, if the window shows the software to be "LogTag Analyzer 2.3" and the version of this guide is 2.3, then the contents of this user guide refer to the version of software being used. If however, this window shows the software to be "LogTag Analyzer 1.0" and the version of this guide is 2.3, then this version of the user guide does not refer to the version of the software being used. The version of this guide is 2.3, which is also shown on the cover page of the guide.

Each time the software is updated one part of the version number of the software is always increased. The "Build" number portion is increased for a given version of the LogTag Analyzer software when the change included in the software will not affect the matching version of the user guide. For example, version 2.3 of the guide refers to both the "LogTag Analyzer, Version 2.3 Build 2" and the "LogTag Analyzer, Version 2.3 Build 5" of the software.
Getting more help

The time may arise when this guide is unable to provide you with the assistance you require. The LogTag Analyzer software includes a way to make the process of getting further assistance from LogTag Recorders as simple as possible, while providing the support team at LogTag Recorders with enough information about your system to be able to provide you with useful assistance. Within the "Help" menu of the software is a "Request help..." command.

This command will gather non personal information from your system to include in the e-mail, which you can review if you want to, so that LogTag Recorders will be informed of the relevant information about your system in order to provide you with quality and useful assistance.

The software will also try to collect as much information as possible from any logger in an interface attached to the computer. It is therefore important you do not remove any logger from attached interfaces while this process continues. You will see following warning message displayed on screen:

![Creating diagnostics e-mail](image)

The file(s) attached will have a *.mem (for memory) file extension which can only be viewed with special diagnostic software by LogTag Recorders, but not with LogTag Analyzer software.

Please also include in the e-mail as much and detailed information as possible about the problem that you are experiencing with the recorders or the software, even if you do not think it is relevant, as the more information is available, the more likely LogTag Recorders will be able to provide you with an appropriate solution quickly.

If you have suggestions for software improvements, you may also use this method to send your ideas to LogTag Recorders, as we are always in the process of improving the software and adding additional features to it, so that the software becomes increasingly more efficient, effective and useful for users.
Appendix

In This Chapter

Connecting to LogTag User Server ........................................... 144
Troubleshooting ................................................................. 146
Finding your computer specifications .................................. 147
Code Pages ............................................................................ 152

Connecting to LogTag User Server

When the software has been customized (see "Customising the software" on page 102) to be connected to the LogTag User Server (see "User Server" on page 127) software, all users are required to successfully logon to the software before being permitted to use any of the features and functionality of the software.

How users log on

For a user to successfully logon to the software, the user must enter their username, which the administrator would have assigned, and their password. Usernames are typically not case sensitive, however passwords are. That is, entering the username "Bob Smith" is the same as entering "BOB SMITH" and "bob smith". However, entering a password of "bob" rather than "Bob", for example, is considered to be different.

Every logon attempt, whether successful or not, may be recorded automatically in the audit logs by the administrator. As a security measure, the network administrator may configure the LogTag User Server (see "User Server" on page 127) software so that a user account becomes locked and therefore temporarily inaccessible if a certain number of consecutive failed logon attempts are made to the user account. Please contact your network administrator if you have problems logging on.

How users change their password

When the software has been customized (see "Customising the software" on page 102) to be connected to the LogTag User Server (see "User Server" on page 127) software, the network administrator may require and/or permit users to change the password used to logon to the software. Users are only permitted to change the password for the user account that is currently logged on, which is typically their own, and as a
security precaution, users will always need to supply their current logon password before being permitted to change it.

The network administrator may enforce certain rules pertaining to what is a valid password. For example, they may require a minimum number of characters (digits, letters or symbols) and/or a minimum number of digits to be included in the password. Please contact your network administrator if you have problems with the logging on the software.

Passwords should be chosen such that they would be difficult for someone else to guess. If another person was able to guess the password they would be able to logon and impersonate the user. Therefore, following are a few points to remember when changing a password:

1. Do not use something that is personal to the user. Birth dates, license plate numbers, names of family members, types of vehicles owned, favorite foods and address of residence are all examples of passwords that should NOT be used.

2. Do not write it down.

3. Change the password on a regular basis.

If a user's password is forgotten, the network administrator will be able to change it. However, network administrators will not be able to see and therefore inform users what their current password is.
# Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>My LogTag appears to be “dead”. No lights are flashing.</td>
<td>This could represent either of two conditions:</td>
</tr>
<tr>
<td></td>
<td>1 The LogTag is ready to start, but has not been started yet.</td>
</tr>
<tr>
<td></td>
<td>2 The LogTag is simply in a state where the configuration has the LED flashing turned off. This is an option that may be selected when a LogTag has been shipped to the user for the first time (to preserve battery life) or it may be that the last configuration setting selected no LED display.</td>
</tr>
<tr>
<td></td>
<td>3 The LogTag is in &quot;Hibernation&quot; mode. Refer to &quot;Prolonging battery life&quot; (see &quot;Hibernation - Prolonging battery life&quot; on page 52) for further information.</td>
</tr>
<tr>
<td></td>
<td>4 The battery is dead and the LogTag is expired. How to test:</td>
</tr>
<tr>
<td></td>
<td>1 Try pressing the START MARK button on the LogTag.</td>
</tr>
<tr>
<td></td>
<td>2 Start the LogTag Analyzer software and place the LogTag into the Interface Cradle. Download the LogTag. If the LogTag can be identified by the software, then the battery is good, and the LogTag is OK.</td>
</tr>
</tbody>
</table>

| I am unable to get a serial port "free". Every time I run the software, every port shows that is already in use | On rare occasions it may be difficult to configure some computers for releasing the assignment of a serial port from one application to another. Often, this will require the services of a computer technician or expert. One simple solution is to purchase a USB Interface Cradle. USB connections do not have a "free port" limitation. |

| What happens if there is an electrical current between the contacts...will that damage the LogTag? | The contacts are isolated from the critical internal component such that incidental static discharge will not harm the LogTag. Deliberate application of a full outlet voltage (100 – 240 volts AC or 12-24 volts DC) to the LogTag may cause permanent damage. |

| I cannot view the user guide that came with the software. | The User Guide is in a 'PDF' file format and as such a special software package called "Acrobat Reader" is required to view it. Acrobat Reader is available for free download from the Adobe web site and can typically be downloaded from [http://get.adobe.com/reader/](http://get.adobe.com/reader/) |

| I cannot see all the readings in the "data" screen, some appear to be missing. | The range of readings shown in the data screen represent the range of readings shown on the Chart screen. Whenever the Chart is zoomed in to show more detail the range of readings shown in the data screen is updated as well. If the chart is zoomed out (Zoom Out) to show all readings that were recorded, then the data screen will also show all the readings that were recorded. |
Why are some of the readings shown "non validated".

The LogTag automatically inserts error detection codes every 127 recordings which checks for the detection of corrupted or manipulated data. If the LogTag has been configured to do continuous recording (see "Continuous operation" on page 46) then as each block of 127 logs is started to be replaced with the latest readings the data integrity error check for the "oldest" block will fail, which will therefore technically putting the block of data into doubt. This is not a problem rather that the particular block of data now has the lost a degree of data integrity protection and hence is labelled 'non-validated'.

Non-validated readings can also occur if there has been communications issues during data transfer from the LogTag or if the memory does actually have a fault, however these causes are very rare.

If above suggestions are insufficient, please check the website at http://www.logtagrecorders.com for more information, specifically the FAQ section.

---

**Finding your computer specifications**

If you are unsure of your computer specifications you can find the relevant information by following these steps:

1. To determine your computer CPU, RAM and version of Windows Operating system:
   
   a) Open the "Control Panel". This can be done by using the mouse to click on the Windows "Start" button, typically located in the bottom left of the screen, to open the Start menu.
   
   b) Once the "Start" button has been clicked, you will see a menu appear.
   
   c) If your menu looks similar to the following picture, click on the visible "Control Panel" item.
d) Within the "Control Panel" window there is a "System" icon. For Windows XP users, you may need to "Switch to Classic View" to locate the "System" icon quickly. Start (open) the "System" icon once you have located it.
e) Clicking on the "General" tab at the top of the "System Properties" window, which is usually the default, will display the relevant information for you about your system.

2 To determine your screen resolution and colors:
   a) Open the "Control Panel" as explained in step 1.
   b) Open the "Display" item.
   c) Click on the "Settings" tab at the top of the "Display Properties" window will display the relevant information for you about your display.
d) From the "Settings" portion of the "Display Properties" window you will see your current screen settings and you may also be able to change some of your display settings if you want.

3 To determine your spare hard disk drive space:
   a) Open "My Computer" which is typically located on your desktop and/or within the Windows "Start" menu.
b) Using your mouse, click the button on the right over the drive that includes "(C:)" in its description.

![Image of My Computer window]

- **System Tasks**
  - View system information
  - Add or remove programs
  - Change a setting

- **Other Places**
  - My Network Places
  - My Documents
  - Shared Documents
  - Control Panel

- **Details**
  - My Computer
  - System Folder

**Files Stored on This Computer**
- Shared Documents
- Username's Documents

**Hard Disk Drives**
- Local Disk (C:)

**Devices with Removable Storage**
- 3½ Floppy (A:)
- DVD Drive (D:)

**Network Drives**

---

c) Select "Properties" (left mouse click) from the popup menu that will appear.
d) Clicking on the "General" tab at the top of the drive properties window will display the relevant information for you about your hard drive.

![Drive Properties Window]

- Type: Local Disk
- File system: NTFS
- Used space: 2,334,171,136 bytes (2.17 GB)
- Free space: 14,031,951,972 bytes (13.8 GB)
- Capacity: 17,166,123,008 bytes (15.9 GB)
- Drive C

- Options: Compress drive to save disk space, Allow Indexing Service to index this disk for fast file search

![Disk Cleanup button]

e) If you have multiple (hard disk) drives installed on your computer you can repeat steps (b) through to (d) for each drive to get the same type of information.
A computer determines which character to display based on a table of values, which is specific to a language. This table is often referred to as the code page.

A small number of characters are independent of a computer's input language. These are '1-9', 'a-z', 'A-Z' and some special characters.

<table>
<thead>
<tr>
<th>0020</th>
<th>0021</th>
<th>0022</th>
<th>0023</th>
<th>0024</th>
<th>0025</th>
<th>0026</th>
<th>0027</th>
<th>0028</th>
<th>0029</th>
<th>002A</th>
<th>002B</th>
<th>002C</th>
<th>002D</th>
<th>002E</th>
<th>002F</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>7</td>
<td>8</td>
<td>9</td>
<td>;</td>
<td>:</td>
<td>&lt;</td>
<td>&gt;</td>
<td>?</td>
<td></td>
</tr>
<tr>
<td>0030</td>
<td>0031</td>
<td>0032</td>
<td>0033</td>
<td>0034</td>
<td>0035</td>
<td>0036</td>
<td>0037</td>
<td>0038</td>
<td>0039</td>
<td>003A</td>
<td>003B</td>
<td>003C</td>
<td>003D</td>
<td>003E</td>
<td>003F</td>
</tr>
<tr>
<td>Ø</td>
<td>A</td>
<td>B</td>
<td>C</td>
<td>D</td>
<td>E</td>
<td>F</td>
<td>G</td>
<td>H</td>
<td>I</td>
<td>J</td>
<td>K</td>
<td>L</td>
<td>M</td>
<td>N</td>
<td>O</td>
</tr>
<tr>
<td>0040</td>
<td>0041</td>
<td>0042</td>
<td>0043</td>
<td>0044</td>
<td>0045</td>
<td>0046</td>
<td>0047</td>
<td>0048</td>
<td>0049</td>
<td>004A</td>
<td>004B</td>
<td>004C</td>
<td>004D</td>
<td>004E</td>
<td>004F</td>
</tr>
<tr>
<td>P</td>
<td>Q</td>
<td>R</td>
<td>S</td>
<td>T</td>
<td>U</td>
<td>V</td>
<td>W</td>
<td>X</td>
<td>Y</td>
<td>Z</td>
<td>[</td>
<td>\</td>
<td>]</td>
<td>^</td>
<td>_</td>
</tr>
<tr>
<td>0050</td>
<td>0051</td>
<td>0052</td>
<td>0053</td>
<td>0054</td>
<td>0055</td>
<td>0056</td>
<td>0057</td>
<td>0058</td>
<td>0059</td>
<td>005A</td>
<td>005B</td>
<td>005C</td>
<td>005D</td>
<td>005E</td>
<td>005F</td>
</tr>
<tr>
<td>`</td>
<td>a</td>
<td>b</td>
<td>c</td>
<td>d</td>
<td>e</td>
<td>f</td>
<td>g</td>
<td>h</td>
<td>i</td>
<td>j</td>
<td>k</td>
<td>l</td>
<td>m</td>
<td>n</td>
<td>o</td>
</tr>
<tr>
<td>0060</td>
<td>0061</td>
<td>0062</td>
<td>0063</td>
<td>0064</td>
<td>0065</td>
<td>0066</td>
<td>0067</td>
<td>0068</td>
<td>0069</td>
<td>006A</td>
<td>006B</td>
<td>006C</td>
<td>006D</td>
<td>006E</td>
<td>006F</td>
</tr>
<tr>
<td>p</td>
<td>q</td>
<td>r</td>
<td>s</td>
<td>t</td>
<td>u</td>
<td>v</td>
<td>w</td>
<td>x</td>
<td>y</td>
<td>z</td>
<td>{</td>
<td></td>
<td></td>
<td>}</td>
<td>~</td>
</tr>
<tr>
<td>0070</td>
<td>0071</td>
<td>0072</td>
<td>0073</td>
<td>0074</td>
<td>0075</td>
<td>0076</td>
<td>0077</td>
<td>0078</td>
<td>0079</td>
<td>007A</td>
<td>007B</td>
<td>007C</td>
<td>007D</td>
<td>007E</td>
<td></td>
</tr>
</tbody>
</table>

Figure 44: ASCII table of printable characters

An additional 128 characters are available, which are specific to each code page. The following examples show for example the differences between the available characters for the Latin and Thai code pages.
In LogTag Analyzer password and user ID fields are text entry fields. The code page is used to determine which characters LogTag Analyzer displays on screen and stores inside a logger. Which code page is selected depends on which input language you have selected for your computer. When the LogTag is downloaded in a different country, the user ID is displayed with the characters from the code page whose reference is stored in the recorder. This is possible because all Windows code pages get installed as part of the operating system installation since the introduction of Windows XP, although only one is used at a time to display characters.

Passwords are always displayed with the asterisk character, but you will need to type them into a confirmation dialogue (especially if the password on download feature is enabled). You can use the Windows character map to enter characters that are not available in your language. To access the Windows character map, enter `charmap.exe` in the "Search" or "Run" box of the Start menu, depending on your operating system, and press Enter.
Some code pages make more than these extra 128 characters available, but this requires more storage in the recorder's memory, which reduces the number of characters available for password and user ID. These languages are Chinese (Traditional), Chinese (Simplified), Korean and Japanese. For every character not in the ASCII character table above, the number of characters that can be stored is reduced by one. This means a password can be as short as 3 characters, and a description as short as 19 characters (or 18 characters for a TRID30-7 or TRED30-7). The sample below shows the extended character overview and a character subset.
You can find more information about the history and technical background of code pages via a number of online references.
Note: Although you can use the Windows character map to confirm a password on download, you cannot enter characters as a new password or description that are not available in your chosen input language with this method. If you want to use different characters you must switch the input language of your computer. Please refer to the instructions relating to your specific operating system how to do this.
# Index

## A
- Advanced Alert Settings • 41, 44
- Advanced FTP settings • 117, 118
- Advanced SMTP settings • 113, 115
- Alert Processing • 28, 38, 42
- Aligning Charts • 83, 87
- Analysing the results • 63
- Appendix • 145
- Automatic e-mailing and uploading to FTP sites • 96, 109, 133, 138
- Automatic Re-Configuration after Download • 53, 57
- Automatically calculated statistics • 88
- Automation • 53, 58, 108, 123
- Average Reading • 88

## B
- Basic FTP settings • 110, 116, 125
- Basic SMTP and e-mail settings • 110, 111, 125

## C
- Calling up previous results • 97, 133
- Changing Chart Colours • 82
- Chart annotations • 67, 68, 70, 75
- Chart Display • 65
- Chart Statistics • 81, 94, 106
- Chart subtitle • 67, 72
- Charts • 38, 41, 67, 68, 81, 82, 83, 86, 107
- Code Pages • 33, 34, 154
- Combining charts onto a single chart • 58, 63, 81, 108, 133
- Communication Ports • 24, 128
- Configuration Profiles • 22, 48, 136
- Configuration Reports • 130
- Configure LogTag(s) for next use • 24
- Connecting the Interface • 18
- Connecting to LogTag User Server • 145
- Continuous operation • 35, 47, 148
- Customising the software • 81, 82, 86, 96, 103, 133, 134, 135, 139, 145

## D
- Data Display • 76
- Dates and Times • 122, 126
- Day Summary Display • 78
- Default display time interval • 105
- Degree Minutes • 93
- Digital signatures • 98, 134
- Display • 120
- Display Logger Alarms • 44
- Display readings after successful download • 109
- Display X items in my most recently used list • 120
- Displaying statistics • 94

## E
- Edit Menu • 68, 134
- Enable automatic download of readings from LogTags • 108, 109
- Exports and Reports • 58, 61, 62, 96, 111, 124

## F
- File and Folder Settings • 109, 120, 124, 133
- File Menu • 58, 59, 62, 71, 73, 97, 101, 120, 132, 140
- File Name • 58, 120
- Finding your computer specifications • 11, 148
- Finding your software version • 9, 14, 138, 143
- Folder Name • 122
- FTP • 109, 118

## G
- General Settings • 69, 105, 134
- Getting a copy of the software • 11, 15
- Getting a LogTag ready for use • 31, 136
- Getting more help • 137, 143
- Getting more information • 143
- Getting results from LogTag • 57, 136
- Getting the best from your LogTag • 47

## H
- Help Menu • 137, 143
- Hibernation - Prolonging battery life • 28, 35, 53, 136, 147
- How secure is my data • 100, 107
- How users change their password • 134, 145
- How users log on • 129, 134, 145

## I
- Inspection and download mark zoom • 68, 105
- Installing the software • 10
- Introduction • 9